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About This User’s Manual

This manual provides detailed instructions on how to set up, use, manage, and maintain Atrust t180L/t180LB
thin clients.

Manual Structure and Subjects

Chapter Subject
1 Provides an overview of Atrust t180L/t180LB thin clients.
2 Provides detailed instructions on how to set up Atrust t180L/t180LB thin clients.
3 Provides the basics of how to use Atrust t180L/t180LB thin clients.

Provides instructions on how to configure client settings and customize Atrust t180L/t180LB

4 thin clients with the Atrust Client Setup console.

Appendices Provides supplementary instructions on advanced settings, maintenance, and upgrade for Atrust
e t180L/t180LB thin clients.

Specifications Provides detailed information on key components of Atrust t180L/t180LB thin clients.

Notes, Tips, and Warnings

Throughout this manual, the notes, tips, and warnings in the following formats are used to provide important
information, useful advice, and prevent injuries to you, damage to your devices, or loss of data on your system.

NOTE

« A note provides important information for a specific situation.

(alll |

TIP

- Atip gives a piece of useful advice to perform a task more efficiently.

74

@ WARNING

« A warning provides crucial information that must be followed to prevent injuries to
you, damage to your devices, or loss of data on your system.



Style Conventions

The following styles are used throughout this manual while referring to operational items on input devices,
hardware panels, or application interfaces.

Item
keys on the keyboard

application windows or
entry lists

buttons or tabs on a
window, toolbars, taskbar,
or menu

options on a window,
screen, list, or menu

selecting a series of options

Style
bold
first letter

capitalized

bold

bold

bold

Example
Ctrl + F2, Alt + F9, Alt + Tab
Confirm Dialog window, RDP Connection list, ICA Connection list,

View Connection list

OK, Next, Save, Applications tab

Add, Domain, Connection Type, High Quality

Applications > Citrix ICA, Applications > Remote Desktop,
Applications > VMware View, Network > Wireless,
Devices > Printer, System > Time Zone



Safety and Regulatory Information

Regulatory Statement

Federal Communications Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of the following measures:

« Reorient or relocate the receiving antenna.
« Increase the separation between the equipment and receiver.
« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate this equipment. This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20 cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.



Regulatory Information

WEEE (Waste Electrical and Electronic Equipment) Directive
In the European Union, this symbol indicates that this product should not be disposed of with
household waste. It should be deposited at an appropriate facility to enable recovery and recycling. For
mmm  proper disposal, please contact your local recycling or hazardous waste center.

Safety Information

@ WARNING

+ Use only power supplies listed in the user instructions.

@ WARNING

« Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

@ WARNING

- For safety, do not make mechanical or electrical modifications to the equipment.

- Do not remove equipment covers and access any of the components inside the
equipment. Any access inside the equipment without an authorized or certified
technician may cause serious injuries and damage. For any problem, contact your
dealer for assistance.

+ You should only make repairs as authorized by the product documentation.
Repairs, replacement, expansion, and upgrades not performed by a certified service
technician may cause injuries to you, damage your system, and void your warranty.
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Overview

This chapter provides an overview of your t180L / t180LB thin clients.

1.1 Introduction
Desktop virtualization and simple endpoint devices 3

1.2 Features
Key features of Atrust t180L / t180LB 3

1.3 Package Contents
Check your package contents 4

1.4 Exterior Views
Overview of thin client outside elements 5

1.5 Panel Components
Descriptions of front and rear panel components 6

1.6 LED Indicators
Descriptions of signals for LED indicators 8
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Introduction

1.1 Introduction

Desktop virtualization provides a new perspective to reconsider the design and implementation of an IT
infrastructure. In a desktop virtualization infrastructure, a station is no longer a cumbersome desktop, but simply an
endpoint device for users to access delivery services from the server(s).

With the introduction of the desktop virtualization technologies, you can considerably benefit from:

- On-demand access to applications / desktops

« Centralized management of work environments

« Drastically reduced endpoint software / hardware issues
«  Simplified system maintenance

« Improved system security

+  More scalability with low-cost endpoint devices

1.2 Features

The key features of Atrust t180L / t180LB thin clients are:

« Support for dual displays (DVI-I and DVI-D)
«  Support for a wide range of desktop virtualization solutions from industry-leading companies:
Microsoft® Remote Desktop
Citrix® XenApp™, XenDesktop®, and VDI-in-a-Box™
VMware® View™ and VMware® Horizon View™
«  Support for high-definition technologies:
Microsoft® RemoteFX®
Citrix® HDX™
VMware® View™ PColP®
- Simple click-access to various applications / desktops

«  Built-in Atrust Client Setup as the local client management console
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1.3 Package Contents

Please check your package contents. Ensure that all of the items are present in your package. If any items are
missing or damaged, please contact your dealer immediately.

Atrust t180L AC Adapter DVI-I to VGA Adapter

Quick Start Guide

Atrust

Atrust t180LB AC Adapter DVI-I to VGA Adapter

Quick Start Guide

NOTE

7

- Your package may not contain a hard copy of the Quick Start Guide. In this
case, a soft copy in PDF format will be provided.
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1.4 Exterior Views
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1.5 Panel Components

O

®

>

Front Panel Components

No. Sign Name Description
1 Power LED Indicates the status of power.
e Press to turn on the thin client.
@ e Press to exit the System Sleep mode.
2 Power button
See page 20 for Suspend feature.
e Long press to power off the thin client.
3 @ Microphone port Connects to a microphone.
4 Q Headphone port Connects to a set of headphones or a speaker system.

USB port
> <> (USB 2.0)

Connects to a USB device.




Rear Panel Components

Overview
Panel Components

No. Sign Component Name Description
6 | ] DVI-I port Connects to a monitor.

7 [ (7] DVI-D port Connects to a monitor.

8 0%» (L:JSS% pzc.)(r)t) Connects to a USB device.

9 SS<~— (LLJJSSBB %?Bt) Connects to a USB device.

10 % LAN port Connects to a network.

11 ===+ DC IN Connects to an AC adapter.

7
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1.6 LED Indicators

Your t180L / t180LB is equipped with a Power LED to indicate the state of power. The meanings of LED signals

are described as follows:

LED Signal Meaning
Off The client is off.
Power LED Orange The client is in System Sleep mode.
Blue The client is on.

The LAN port of your t180L / t180LB has two LED indicators showing the state of networking. The meanings of

LED signals are described as follows:

SPEED LED LINK/ACT LED
SPEED LED LINK/ACT LED .
(transmission rate) (linking/transmission activity) Meanlng
Off Off The client is not connected to a LAN.
Off Amber blinking The client connects to a 10 Mbps LAN.
LED Signal
Orange Amber blinking The client connects to a 100 Mbps LAN.
Green Amber blinking The client connects to a 1000 Mbps LAN.




Setting Up Your t180L / t180LB

This chapter provides detailed instructions on how to set up your
t180L / t180LB thin clients.

2.1 Positioning Your t180L / t180LB
To mount your t180L

Step 1: Remove the Stand from Your t180L

Step 2: Understand Your Stand / VESA Mount Kit for t180L
Step 3: Store Screws inside the Bracket

Step 4: Remove Screws from the Bracket

Step 5: Mount Your t180L

Mounting with Another VESA Bracket (t180LB)

2.2 Assembling the AC Adapter
How to assemble the AC adapter and its detached plug

2.3 Getting Connected
How to connect peripherals and power for t180L / t180LB

16

16






2.1

Setting Up Your t180L / t180LB
Positioning Your t180L / t180LB

Positioning Your t180L / t180LB

There are two ways to position your t180L:

Put it (with its stand) on a desk or a desired place uprightly.

Mount it on the back of a monitor using a VESA mount kit.

To mount your t180L on the back of a monitor, please follow the steps below:

Step 1: Remove the Stand from Your t180L

Step 2: Understand Your Stand / VESA Mount Kit for t180L

Step 3: Store Away Screws inside the Bracket

Step 4: Remove Screws from the Bracket

Step 5: Mount Your t180L

5/

NOTE

- If your t180 uses a non-standard stand with the wireless module, you will need a
different VESA bracket to mount it on the back of the monitor. For details, please
refer to topic “Mounting with Another VESA Bracket (t180LB)” on page 15.

Step 1: Remove the Stand from Your t180L

To remove the stand from your t180L, please do the following:

1.

2.

Place your t180L on a flat surface with the stand side upward.
Remove the screw that fixes the stand to your t180L.

Store away the removed screw inside the stand. Detailed instructions will be
provided in Step 2 and 3.

=

NOTE

« It's highly recommended to store screws away inside the stand when not needed
to prevent them getting lost.

11
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Step 2: Understand Your Stand / VESA Mount Kit for t180L

The stand for your t180L is dual-purpose: it can be used as a stand or as a VESA mount kit. All screws of different
types supplied with the stand / VESA mount kit can be stored away inside the main bracket when not needed.

Screws Stored Away inside the Bracket

The following figure shows different types of screws stored away inside the main bracket.

Dual-purpose —-(O O O ON
bracket
(R

o [zmn)
.
12 L
O

O O 0

Screw Type Number Description

1 5 The largest-size screws used to secure the bracket to a monitor as a VESA mount if the
middle-size screws cannot firmly secure the bracket and your t180L to the monitor.

> 4 The middle-size screws used to secure the bracket to your t180L and to a monitor
when using the bracket as a VESA mount.

3 1 The smallest-size screw used to secure the bracket to your t180L as a stand.

Mount Holes on the Bracket

Refer to the following figure and descriptions for the VESA mount holes on the bracket.

1—fO O O O} 1
2 ”om-'—'ru-'—“”—‘mon 2

el el
2 QY iimminia s nmin® ), 2

Mount Hole Description

1 The VESA mount holes used to secure the bracket to a monitor (only two of them will be used).
2 The VESA mount holes used to secure the bracket to your t180L (only two of them will be used).
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Step 3: Store Screws inside the Bracket

To store screws inside the bracket, please do the following:

%J NOTE

It's highly recommended to store screws inside the bracket when not needed
to prevent them getting lost.

Place a sheet of paper or a piece of cloth on a flat surface, and then put your bracket on that paper or cloth
with the screw storage side upward.

Place the screw upon its storage space, and push the screw into the space with your finger until it clicks
into place. For the smallest-size screw, use the tip of a screwdriver instead to push the screw.

% ) NOTE
— « Please refer to the figure and descriptions in “Step 2: Understand Your Stand / VESA
Mount Kit for t180L" for the correct storage space of each screw.

Step 4: Remove Screws from the Bracket
To remove screws stored inside the bracket, please do the following:

1. Place a sheet of paper or a piece of cloth on a flat surface, and then put your bracket on that paper or cloth
with the screw storage side downward.

2. Insert the tip of a screwdriver into the square holes to remove the desired screws from the bracket.

Square Hole

13
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Step 5: Mount Your t180L

To mount your t180L on the back of a monitor, please do the following:

1. Refer to Step 2 and Step 4 to prepare required screws for mounting your t180L.

+ You will need two (2) screws of type 9 to secure the bracket to your t180L.
+ You will need two (2) screws of type 0 or 9 to secure the bracket to the monitor.

2. Place your t180L on a flat surface with the VESA mount hole side upward.

3. Refer to Step 2 to choose two of the four VESA mount holes on the bracket to align with two mount holes
on your t180L such that the bracket projects out and is closer to the rear panel than the front one as shown

below, and then secure the bracket to your t180L with two (2) screws of type .

4. Align the mount holes on the bracket with the mount holes on the back of the monitor, and then secure the
bracket to the monitor with two (2) screws of type 9 or 0 Ensure that your t180L is located in the center
of the monitor and the rear panel of your t180L is facing rightward as shown below.

Have t180L’s rear panel
facing rightward.
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Mounting with Another VESA Bracket (t180LB)

In case that your t180 uses a non-standard stand with the wireless module (t180LB), a different VESA bracket will be
provided for you to mount your t180LB on the back of a monitor.

To mount your t180LB, follow the steps below:

1. Align two mount holes on the VESA bracket with two mount holes on your t180LB, and then secure the
bracket to your t180LB with two (2) screws as shown below.

2. Align the mount holes on the VESA bracket with the mount holes on the monitor, and then secure the
bracket and t180LB to the monitor with two (2) screws as shown. Ensure that your t180LB is located in the
center of the monitor and the rear panel of your t180LB is facing rightward as shown below.

Have t180LB’s rear panel
facing rightward.




16| Setting Up Your t180L / t180LB
Assembling the AC Adapter

2.2 Assembling the AC Adapter
To assemble the AC adapter for your t180L / t180LB, please do the following:

1. Unpack your thin client package and take out the AC adapter
and its detached AC power cord.

2. Press the female end of the power cord into the male connector
of the AC adapter.

% ) NOTE
— + The plug of the supplied power cord may vary with your area.

2.3 Getting Connected
To make connections for your t180L / t180LB, please do the following:

1. Connect your t180L / t180LB to your local network with an Ethernet cable.
Connect a keyboard and mouse to your t180L / t180LB with USB ports.

Connect and turn on the monitor(s).

> N

Connect your t180L / t180LB to a power outlet using the AC adapter included in the package.

% NOTE
= « For detailed instructions on how to assemble the supplied AC adapter, please refer
to section “2.2 Assembling the AC Adapter” on page 16.

5. Connect other peripherals for your t180L / t180LB if needed.



Getting Started

This chapter provides the basics of how to use your t180L/t180LB.

3.1 Learning the Basics
Topic 1: Powering On Your t180L/t180LB
Topic 2: Configuring the Time Zone
Topic 3: Returning to the Quick Connection Screen
Topic 4: Accessing Desktops or Applications

20
21
22
23
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Learning the Basics

3.1 Learning the Basics

The following topics will guide you through the basics of using your t180L/t180LB:

Topic 1: Powering On Your t180L/t180LB
Topic 2: Configuring the Time Zone
Topic 3: Returning to the Quick Connection Screen (if needed)

Topic 4: Accessing Desktops or Applications

«  Microsoft Remote Desktop Services (RDP sessions)
«  Citrix Services (ICA sessions)

« VMware View or Horizon View Services (View sessions)

NOTE

g
: + Three client modes are available for your t180L/t180LB:

No. Mode Description

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

+ In Quick Connection mode, you can access Microsoft Remote Desktop / Citrix /
VMware View or Horizon View services quickly without much client configuration
required. The main purpose of this chapter is to guide you through the use of your
t180L/t180LB under the Quick Connection mode.

«+ To understand other modes, configure advanced settings, and customize your
t180L/t180LB, please refer to chapter 4 “Configuring Client Settings” on page 37.

19
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Learning the Basics

Topic 1: Powering On Your t180L/t180LB
To start using your t180L/t180LB, please do the following:

1. Ensure that your monitor is connected and turned on.

NOTE

&

- Please note that you need to connect and turn on your monitor before powering
up the thin client. Otherwise, the client may fail to set an appropriate resolution
for the connected monitor.

2. Press the Power button to turn on the client. Wait a moment for Atrust Quick Connection screen to appear.

3. (a) Go to Topic 2 to set the time zone for the first time use.
(b) Go to Topic 4 if the time zone had been set.

Atrust Quick Connection Screen

Atrust Quick Connection

"% Remote Desktop

Citrix

B VMware View

Atrust

T

¢ @3

Power Off Local Desktop Setup Mixer Network

Power Off Click the icon to suspend, shut down, or restart the system.

Click the icon to enter the local Linux desktop.

Lozl [Des Sify To return to this screen from the local Linux desktop, see Topic 3.

Setup Click the icon to launch Atrust Client Setup.

Mixer Click the icon to configure audio settings.

Indicates the network type (wired or wireless) and status.

Network Click the icon to configure network settings.




Topic 2: Configuring the Time Zone
To set the time zone for your t180L/t180LB, please do the following:

1. Click the Setup @ icon to launch Atrust Client Setup.

Atrust Client Setup

® Atrust Client Setup

Crn e RN |
Atrust Applications  User Interface Devices Network System
. . Remote Desktop
Nav|gat|°n Area e Citrix ICA il . Remote Desktop 2vzilable Sessions: 0
- VMware View &4 configure ROP (Remote Desktop Protocol) connection settings

Click to select - ssH
. B Pel} Citrix ICA Available Sessions: O

a Settlng Item Configure Citrix ICA connection settings
or entry.

[+ YMware View Avallable Sessions: 0

s configure ViMware View connection settings

S8H Available Sessions: 0
Configure SSH (Secure Shell) session settings

5/ NOTE
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Category Tabs
Click a tab to select
a setting category.

« For detailed instructions on how to configure client settings and customize your
t180L/t180LB with Atrust Client Setup, please refer to chapter 4 “Configuring Client

Settings” on page 37.

2. On Atrust Client Setup, click System > Time Zone.

System

® Atrust Client Setup *
Atrust Applications  User Interface Devices Network System
Time Zone )
L= 0 Navigator General
Time Zone
- Password ¢ Time Zone
- Firmware Update Time Zone: GMT -l e
-~ Appliance Mode L ]
- Auto Setup
- Quick Connection ( NTP 1
- Terminal | NTP Server Address * [pool.ntp.org =
Taport L ]
— ke Manager
| Save l

H save || cancel
—y |V

3. Click the Time Zone drop-down menu to select the desired time zone.

4. Click Save to apply, and then close Atrust Client Setup.

Time Zone
drop-down menu
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Topic 3: Returning to the Quick Connection Screen

To return to Atrust Quick Connection screen when on local Linux desktop, please double click
Atrust Quick Connection on that desktop.

Local Linux Desktop

Atrust Quick Connection

Bl e useroar. |
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Topic 4: Accessing Desktops or Applications

Through Atrust Quick Connection screen, you can access three types of desktop virtualization services:
Remote Desktop, Citrix, and VMware View.

Atrust Quick Connection Screen

= Remote Desktop

Citrix
Atrust Quick Connection

"= Remote Desktop @ VMware View

Citrix

5 VMware View

Atrust

L

Icon Description Page
Remote Desktop Click to access Microsoft Remote Desktop services. 24
Citrix Click to access Citrix XenApp, XenDesktop, or VDI-in-a-Box services. 25

VMware View Click to access VMware View or Horizon View services. 34
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Accessing Microsoft Remote Desktop Services

To access Microsoft Remote Desktop services, please do the following:

1. Click BERRtEE I o, Atrust Quick Connection screen (see the screen in Topic 4).

2. On the appeared window, type in the computer name or IP address of the server, user name, password, and
domain (if any), and then click Connect.

~

d

Session name: <Quick Connection: 'I
MR- ]
WMS

Remote Destkop
Connection

___ To return to the previous screen, press Esc.
) Use Alt + Tab to select and restore a hidden or minimized
~  application or deskiop session.

—=)) NOTE

Ll

« To discover available Windows MultiPoint Server systems over your network,
please do the following:

ey
1. Click we™ on the left of the Computer field.
2. Upon completion, a window appears with the search result.

Confirm Dialog

Windows MultiPeint Servers' list, please select one that you
want to connect:

|EE-SV1 (192.168.11.108) ﬂ

3. Click the drop-down menu to select the desired system, and then click OK.
4. The IP address of the selected system will appear in the Computer field.

» To return to Atrust Quick Connection screen (see the screen in Topic 4), press Esc.

3. The remote desktop will be displayed on the screen.
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Accessing Citrix Services

Connecting to the Server

To connect to the server through which Citrix services are accessible, please do the following:

1. Click on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the appeared Atrust Citrix Connection screen, enter the appropriate IP address / URL / FQDN of the server,
and then click Log On.

Atrust Citrix Connection Screen

Citrix Receiver

NOTE

(alll |

- For newer versions of XenDesktop and XenApp, you may need to further specify
the sub-path of the server. Refer to the following table for details:

Component to

Citrix Product Connect

Connection Address

XenApp 6.5 or

earlier Web Interface IP / URL / FQDN

XenDesktop 5.6

or earlier Web Interface IP / URL / FQDN

IP / URL / FQDN plus sub-path

For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenApp and
XenDesktop 7.5

+ FQDN is the acronym of Fully Qualified Domain Name.

- To return to Atrust Quick Connection screen (see the screen in Topic 4), press Esc.

25
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Logging On to Citrix Services

When connected to the server, the Citrix Logon screen appears. The appeared screen and required credentials for
Citrix services may vary with the service type and version.

@ NOTE

« A warning message “This Connection is Untrusted” might appear. Consult the
IT administrator for details and ensure the connection is secure first. To import
a security certificate, please refer to section “4.2.14 Importing Certificates for
Remote Computers” on page 64.To bypass, click | Understand the Risks > Add
Exception > Confirm Security Exception.

The following are some examples of Citrix Logon screens.
XenDesktop 5.6 Platinum:
Citrix Logon Screen

Citrix XenDesktop

Type the required
user name, password,
and then click

Log On to access
virtual desktops.

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet

CITRIX (0%

@ NOTE

+ To return to Atrust Quick Connection screen, press Esc.
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XenApp 6.0 Fundamentals:

Citrix Logon Screen

Type the required

user name, password,
domain, and then click
Log On to access
virtual applications.

NOTE

(]

+ To return to Atrust Quick Connection screen, press Esc.

- If your XenApp server doesn’t belong to any domain, type the computer name of
the server in the Domain field.

XenApp 6.5 Platinum:

Citrix Logon Screen

Citrix XenApp

Type the required

user name, password,
domain, and then click
Log On to access
virtual applications.

Logon

e
s I
-

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

cimRx (=2

NOTE

Wl

« Toreturn to Atrust Quick Connection screen, press Esc.

« If your XenApp server doesn’t belong to any domain, type the computer name of
the server in the Domain field.
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VDI-in-a-Box:

Citrix Logon Screen

Type the required user
name, paSSWOrd, Citrix Receiver

and then click

Log On to access
virtual desktops.

NOTE

ol

+ To return to Atrust Quick Connection screen, press Esc.

XenApp and XenDesktop 7.5 Platinum:

Citrix Logon Screen

Type the required user CitrixReceiver
name, password,

and then click

Log On to access
virtual desktops.

NOTE

(i)

« Toreturn to Atrust Quick Connection screen, press Esc.
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Accessing Virtual Desktops and Applications

You will enter the Desktop Selection or Application Selection screen after logon. On the screen you can click to select
the desired desktop or application(s).

5’/ NOTE

+ You might enter the virtual desktop directly if only one type of virtual desktop is
assigned to the provided credentials.

TIP

« Use Alt + Tab to select and restore a hidden or minimized application or desktop.

@

The following are some examples of Selection screens and delivered desktops and applications.
XenDesktop 5.6 Platinum:

1. The Desktop Selection screen appears after logon.

Desktop Selection Screen

& cmx

Setings Log

2. Click to select the desired desktop.

3. The selected virtual desktop will be displayed on the screen.
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Virtual Desktop Example: Windows 7 Ultimate

) Wecometoyou i HenDeskiop

Welcome to the virtual workstyle

Your desktop, jocuments at your fingertips
urv ine freedom t0 do whatever, wheneve

—w
20 a4

XenApp 6.5 Platinum:

1. The Application Selection screen appears after logon.

Application Selection Screen

—— S8 cmpe

2. Click to select the desired application(s).

3. The selected application(s) will be displayed on the screen.
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Virtual Application Examples
PowerPoint Viewer, Adobe Reader, and Notepad

Open a Recent File Acrobat.com Services

TR cresepor onine

i/ NOTE

« Clicking on Application Selection screen will bring the screen to the front and leave
all launched application windows hidden behind. Use Alt + Tab to select and restore

a hidden or minimized application window.

+ Exiting a virtual desktop or application will return to the Desktop Selection or
Application Selection screen. On the screen, you can:

< Click to launch another virtual desktop if any or to launch other applications.
<~ Click Log Off on the top of the screen to return to the Citrix Logon screen.
< Press Esc to return to Atrust Quick Connection screen directly.

XenApp and XenDesktop 7.5 Platinum:

1. The Application Selection / Desktop Selection screen appears after logon.

Application Selection Screen
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You might see this
screen when you log
in to XenApp 7.5 for
first time. Just click
to add your favorite

apps from a list. Al ADD YOUR

~ || FAVORITE APPS}

Desktops

— Two buttons may be available
for your to switch between
Application and Desktop
Selection screen, depending on
your server-side deployment.

Desktop Selection Screen

2. Click to select the desired application(s) or desktop.

3. The selected application(s) or desktop will be displayed on the screen.
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Virtual Desktop Example: Windows Server 2008 R2

Virtual Application Examples
Adobe Reader, Mozilla Firefox, and PowerPoint Viewer

vecmas §) 8 12 5 11 5

=) NOTE

« Clicking on Application Selection screen will bring the screen to the front and leave
all launched application windows hidden behind. Use Alt + Tab to select and restore
a hidden or minimized application window.

« Exiting a virtual desktop or application will return to the Desktop Selection or
Application Selection screen. On the screen, you can:

<~ Click to launch another virtual desktop if any or to launch other applications.
< Click Log Off on the top of the screen to return to the Citrix Logon screen.
< Press Esc to return to Atrust Quick Connection screen directly.

33



34| Getting Started
Learning the Basics

Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Click on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the opened window, double-click Add Server icon or click New Server in the top-left corner. A window
appears prompting for the name or IP address of the VMware View Connection Server.
3. Enter the required information, and then click Connect.

P N
_le Connecl

VMware Horizon Client

File Connection View Help

+ New Server

+ New Server

Add Server

Enter the name of the Connection Server,

|

annec_t |

Add Server

NOTE

- To return to Atrust Quick Connection screen (see the screen in Topic 4), close the
opened window.

=

4. A Welcome window might appear, click OK to continue.

5. A window appears prompting for the credentials. Enter your user name, password, click the Domain
drop-down menu to select the domain, and then click OK.

Server Login

vmware Horizon

Server: (@ bitps:/AMCSVHV.poc

Username: |\ |

Password: | |

Domain: |‘u’H\f | A4 |

Cancel | |
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@‘/ NOTE

« A window might appear with a certificate message about the remote server.
Consult the IT administrator for details and ensure the connection is secure first.

To import a security certificate, please refer to section “4.2.14 Importing Certificates
for Remote Computers” on page 64.To bypass, click Connect Insecurely.

6. The Desktop and Application list appears with available desktops and/or applications for the provided
credentials. Double click to select the desired desktop or application.

VMware Horizon Client

Eile Connection View Help

ErR| e | N
&Y [ HitpsIMVTS VHVipoT

Adobe Reader X| Caleulator

aJ 0 =

Notepad Paint Skype

7. The virtual desktop or application will be displayed on the screen.

Virtual Desktop Example
Windows 7 Ultimate

File ¥ Connection~ View~ Help~ | (0 @ X
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Virtual Application Examples (VMware Horizon 6 with View)
LINE, Adobe Reader, Mozilla Firefox, and Calculator

B Viwere Horzon e

Fie ~ Connection~ View~ Help~ | 0 B X

LINE

Login QR Code Login

Login

e ||{B- coogle

B8 fdebeResder
Fie Gt View Window Hep

==

=]

B My Computer..

B2 Acobstom

Do | JBZFeBEE|®[]

Recent Files | View All

IEaeE Tols

Fill & Sign

‘Adobe ExportPDF
Comvert PDFfles to Word or Excel
oniine.

Select POF Fil:

Adobe Online Services

R cemeror
@, st
[ Gt vocumens sgnea

G Store YourFiles Online

vvvvvvvv

Recognize Tetin Engish(U:
e SR

Comment

Microsoft Word (*doc) -

Google Search

(GNY

Let the worid know you #Chooselndependent
with Firefox.

* O & O %

Bookmarks  History Syme Options

@ Restoe revous sef| ===

% ) NOTE

-s

- Your desktop or application will be displayed in full screen. You can:

< Click File > Return to Desktop and Application List on the top tool bar to

recall the Desktop and Appl

VMware Horizen Client

ication list.

File = | Connection ¥ View~ Help~ | (@ @ X
4r Disconnect from Server...
\ Return to Desktop and Application List

wf Preferences

o Quit

< Click View on the top tool bar to switch to a virtual desktop or application.

VYMware Horizen Client

File ¥ Connection» |View = |Help~ | (@ @ X

C Windowed

® Full Screen - This Monitor

O Full Screen - All Monitors
Resize

Adobe Reader

@ Firefox

CJLINE

[ Windows Calculator
= W7U
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This chapter provides instructions on how to configure advanced
settings and customize your t180L/t180LB with Atrust Client Setup.
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4.1 Atrust Client Setup

Your t180L/t180LB comes with Atrust Client Setup, the built-in local client management console to help you
configure client settings and customize your t180L/t180LB.

4.1.1 Interface Overview
To access Atrust Client Setup on your t180L/t180LB, please do the following:
1. On Atrust Quick Connection screen, click the Setup @ icon to launch Atrust Client Setup.

2. The Atrust Client Setup window appears.

Interface Overview

o (2] ® O 6

.
.
.
.

ecece
ecee
ecece
ecece

® Atrust Client Setup | = Rl B
.

O

g g g
Atru'—'-'t Applications User Interface Devices Network System

(6 I oy
Citrix ICA el , Remote Desktop ~vallable Sessions: 0

s WMware View & Configure RDP (Remote Desktop Protocol) connection settings

ececde

Citrix ICA Awailable Sessions: 0
Configure Citrix ICA connection settings

HHd VMware View Available Sessions: 0
— Configure VMware View connection settings

SSH Available Sessions: 0
<= Configure SSH (Secure Shell) session settings

Interface Elements

No. Name Description
1 Applications tab Click to configure settings for service access through the client.
2 User Interface tab Click to configure settings for the user interface of the client.
3 Devices tab Click to configure settings for external devices of the client.
4 Network tab Click to configure settings for the connectivity of the client to networks and servers.
5 System tab Click to configure settings for the operation and maintenance of the client.
6 Navigation area Click to select a setting item under a selected tab or to select a setting entry under

a selected setting item.

7 Configuration area Configures setting values when a setting item or entry is selected.
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4.1.2 Client Settings at a Glance

The following table provides a brief description of each setting item under five main setting categories.

Tab

System

User Interface

Devices

Network

Applications

Setting Item

Configuring time zone and time server
Configuring passwords

Configuring remote assistance settings
Updating firmware

Enabling/Disabling the Appliance mode
Enabling Auto Setup

Configuring Quick Connection

Enabling/Disabling the execution of the
text-based (command-line) functions
Collecting event logs, capturing related
screens, and then uploading files for
error reporting

Importing certificates for remote computers

Enabling/Disabling Auto Registration

Configuring display settings

Customizing desktop and system language

Hiding/Showing Quick Access shortcuts
Using a custom wallpaper

Adjusting keyboard settings

Adjusting mouse settings

Configuring screensaver settings

Configuring settings for USB storage devices

Configuring settings for audio devices

Configuring settings for local/network printers

Configuring wired network settings
Enabling/Disabling Wake On LAN
Configuring VPN settings

Creating the mapping of IP addresses to the

names of host servers

Creating the Failover Cluster list
Changing the host name of your client
Configuring wireless network settings

Configuring proxy settings for Web-based

access to services

Configuring Microsoft RDP connection settings
Configuring Citrix ICA connection settings
Configuring VMware View connection settings

Configuring SSH connection settings

Section

4.2 Configuring System Settings

4.3 Configuring User Interface Settings

4.4 Configuring External Device Settings

4.5 Configuring Network Settings

4.6 Configuring Service Access Settings

Page
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4.2 Configuring System Settings

4.2.1 System Tab Overview

System tab enables you to configure settings for the operation and maintenance of clients. To access available
settings of System tab, click the tab on Atrust Client Setup.

System Tab Overview
® Atrust Client Setup Gillod LGS
Atl'l.lSt Applicati User Interf: Devices Network System

(1 PO .

Password T Time Zone =0 .......9

- Firmware Update O set the time zone and time server

~Appliance Mode

Auto Setup

~Quick Connection l Password

-~ Terminal
-Error Report

- Certificate Manager 4% Firmware Update
- Advanced _— X
Update firmware through the network

Configure administration privileges and remote assistance settings

%, Appliance Mode

Configure Appliance mode

E. » Auto Setup
== Configure Auto Setup Mode

[P_g Quick Connection

Configure Quick Connection mode

Terminal

&L Configure the access of command-line interface

@ Error Report
Collect information for troubleshooting

Interface Elements

No. Name Description

1 Navigation area Click to select a setting item under System tab.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4.2.2 Available Settings at a Glance

Tab Setting Icon
i 7
Time Zone o)

Password “

Firmware Update AN
Appliance Mode ~

Auto Setup

System _

Quick Connection

Terminal

Error Report

Certificate

Manager

Advanced Ar
NOTE

Bl

& 17

4

¥

Description

Click to configure the time zone and time server
for your t180L/t180LB.

Click to configure the access privileges of Atrust
Client Setup for t180L/t180LB users.

Click to configure settings for remote assistance.

Click to update firmware through the network.
This feature is applicable to the client only when

the client is managed by the remote Atrust Device

Manager console.

Click to enable/disable the Appliance mode to
allow/disallow the automatic RDP / ICA / View
sessions. In Appliance mode, the client starts up

directly with the desired RDP / ICA / View session

and performs the configured action after exiting
the session.

Click to enable Auto Setup to allow the client to
get its preset configuration on startup and enter
the desired user environment automatically.

Click to configure the Quick Connection mode.

Click to enable/disable the execution of the
text-based (command-line) functions.

Click to collect error log and launch the screen
capturing program for error reporting.
Click to upload files to a specified FTP server for

error reporting.

Click to import or manage certificates for
remote computers.

Click to configure advanced settings such as
Auto Registration.

+ Atrust Device Manager is a remote and mass client management console,

helping you remotely manage a large number of endpoint devices in a desktop
virtualization infrastructure. For more information about Atrust Device Manager,

please refer to the User’s Manual for Atrust Device Manager.

Section
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4.2.5

4.2.6

4.2.7
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4.2.3 Configuring Time Zone and Time Server

The Time Zone setting allows you to configure the desired time zone and time server to get the accurate system
time for your t180L/t180LB.

To set the desired time zone and time server, please do the following:

1. On Atrust Client Setup, click System > Time Zone.

" LEEEE
® Atrust Client Setup o alliCS

Atl'l.lSt Applicati User Interf: Devices Network System

General

- Password - Time Zone .
- Firmware Update ‘ Time Zone: ST = ‘
- Appliance Mode \ | _I [ |
- Auto Setup

- Quick Connection ( NTP "
-~ Terminal ‘ NTP Server Address * |poo|.ntp.org ‘ E ‘
~Error Report 8 |
- Certificate Manager

| Save l | Cancel

2. Under the Time Zone section, click the drop-down menu to select the desired time zone.

3. Under the NTP (Network Time Protocol) section, use the default or type in the desired time server.

NOTE

« The IP address of the default time server is pool.ntp.org. For more information on
the default, please refer to the website for the NTP Pool Project at www.pool.ntp.org.

(allt}

+ Ensure the connectivity of your t180L/t180LB to the network or Internet in order to
get accurate time from the time server.

4. Click Save to apply.
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4.2.4 Configuring the Access Privileges and Passwords of Atrust Client Setup

You can configure the access privileges of Atrust Client Setup for t180L/t180LB users by the Password setting.

NOTE

]

« All t180L/t180LB users are allowed to access Atrust Client Setup by factory default.
You can make changes as desired using this setting.

Setting Access Privileges and Password Only for Administrators
To set access privileges and password only for administrators, please do the following:

1. On Atrust Client Setup, click System > Password.

®) Atrust Client Setup o+
Atrust Applications  User Interface Devices Network System
Navigator General
- Time Zone
Password ¢ Administrator

Firmware Update

d = Active Admin Authorization
- Appliance Mode L

- Auto Setup
- Quick Connection ( Shadow

Terminal .. ¥ Enable Shadow
~Error Report

- Certificate Manager Change Password

| Save H Cancel |

2. Under the Administrator section, click to check Active Admin Authorization.

3. The access privileges for administrators are granted and a window appears for you to set the password.

- - T e
® Set Password diala
Confirm Password = :]

* Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.
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Setting Access Privileges and Password Also for Standard Users
To set access privileges and password also for standard users, please do the following:

1. On Atrust Client Setup, click System > Password.

2. Under the User section, click to check Active User Authorization.

® Atrust Client Setup o alliCS

Atl'l.lSt Applicati User Interf: Devices Network System

Navigator General

- Time Zone
Password ¢ Administrator

- Firmware Update L ¥ Active Admin Authorization

- Appliance Mode

- Auto Setup Change Password

-~ Quick Connection

-~ Terminal

~Error Report

- Certificate Manager

s User
|'_ Active User Authorization

¢ Shadow
L. ¥ Enable Shadow

Change Password

Save ] | Cancel

%J‘ NOTE

« The User section appears only when Active Admin Authorization is checked.

3. The access privileges for standard users are granted and a window appears for you to set the password.

® Set Password

Confirm Password = :]

*Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.

a5
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4.2,5 Configuring Shadow Settings for Remote Assistance

The Shadow feature allows an administrator to remotely assist client users in resolving problems or configuring local
settings. When this feature is enabled, an administrator can monitor and control a client from a remote computer
just like a local user.

S NOTE
+ To use the Shadow feature on a remote computer, you need to install the Atrust
Device Manager console on that computer, and add your t180L/t180LB into a
managed group under Atrust Device Manager. For details, please refer to the
User’s Manual for Atrust Device Manager.

To enable the Shadow feature and set the password for remote assistance, please do the following:

1. On Atrust Client Setup, click System > Password.

® Atrust Client Setup | =W | NN [

Atl'l.lSt Applicati User Interf: Devices Network System

Navigator General

- Time Zone

Password ¢+ Administrator
- Firmware Update
Appliance Mode
uto Setup
- Quick Connection ¢ Shadow y
- Terminal L. ¥ Enable Shadow ‘

‘ ' Active Admin Authorization ‘

~Error Report
Certificate Manager

Change Password

| Save H Cancel J

2. Under the Shadow section, click to check Enable Shadow if it's not checked.

% -) NOTE
— « By default, the Shadow feature is enabled. Click Change Password, and then follow
the next step to set your password.

3. The Shadow feature is enabled and a window appears for you to set the password for remote assistance.
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o e b e
® Set Password il as

Confirm Password * :]

* Your password can contain letters, numbers, and
special characters.
* It must be 4 to 8 characters long.

NOTE

i)

- On aremote computer, an administrator will need this password to use the Shadow
feature (remote assistance) with the Atrust Device Manager console. For more
information, please refer to the User’s Manual of Atrust Device Manager.

4. Type in the desired password, and then click OK to confirm.
5. Click Save to save all the changes.

NOTE

oll]

« When the Shadow feature is performed from a remote Atrust Device Manager, on
the target client, an icon appears on the Taskbar of the local Linux desktop
and a notification pops up in the bottom-right corner. If you are under the Quick

Connection mode (the default for t180L/t180LB thin clients), a notification would
pop up in the upper-left corner on Atrust Quick Connection screen.
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4.2.6 Updating Firmware from the Management Computer

Update Firmware allows client users to update firmware from its management computer.

= NOTE
=z
- Ensure that your t180L/t180LB has been added into a managed group under Atrust

Device Manager installed on a remote computer, and that you have imported client

firmware files into Atrust Device Manager. These are prerequisites of this feature.

+ For more information on firmware update and Atrust Device Manager, please refer
to the User Manual for Atrust Device Manager.

To update firmware from the management computer, please do the following:

1. On Atrust Client Setup, click System > Firmware Update.

Atrust Client Setup AR e

Devices Network System

Atrust A

User Interf:

General

- Time Zone

- Password
Firmware Update

- Appliance Mode

- Auto Setup

uick Connection

- Terminal

~Error Report

Certificate Manager

- Firmware Update

Current Version: Ver. 2.33-INTL

This sefting will take effect after reboof.

Check Firmware

Cancel

2. Under the Firmware Update section, click Check Firmware.

3. Upon completion, a window appears notifying you that the Firmware list has been loaded.

4. Click Yes to continue.

®

O

Confirm Dialog

List Loading Completed!

iy
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5. Click the drop-down menus to select the desired firmware version and other update options.

® 0 =

Atrust

- Time Zone

- Password

Firmware Update

- Appliance Mode
Auto Setup
- Quick Connection
- Terminal

~Error Report

Certificate Manager

Atrust Client Setup AR e

Applicati User Interf: Devices Network System

General

- Firmware Update
Current Version: Ver. 2.33-INTL

Firmware Version: |ATRUSTL\NUX 2.34-INTL hd
Language: | English hd il T
Reboot Immediat ely: [Mo -l o
Keep the User Data: [vES | =

Check Firmware

This setting will take effect after reboot.

Update ﬁrmwarel ‘ Cancel

Firmware Update Options

Item

Description

Firmware Version

Click to select the desired firmware version.

Language

Click to select the interface language of the system, including the
Atrust Client Setup console.

NOTE: Available languages may vary with the selected firmware version.

Reboot Immediately

Click to choose whether to restart the system immediately for firmware update
or manually restart the system later.

Keep the User Data

Click to choose if to keep the setting values under Atrust Client Setup.

NOTE: If Yes is selected, all setting values under Atrust Client Setup will remain
unchanged after firmware update.
If No is selected, all setting values will be restored to the factory default.
This option may not be available on your system.
NOTE: If the client is managed by Atrust Device Manager and here No is
selected, Atrust Device Manager will fail to manage the client after
firmware update. For more information on Atrust Device Manager, please
refer to the User’s Manual for Atrust Device Manager.

6. Click Update firmware to confirm your selections. The system will start updating its firmware after restart.

49



50| Configuring Client Settings
Configuring System Settings

4.2.7 Enabling or Disabling the Appliance Mode

The Appliance mode allows your t180L/t180LB to start up directly with the desired Microsoft Remote Desktop,
Citrix ICA, VMware View or Horizon View session. Under this mode, users will feel as if they were using a standalone
desktop computer; the underlying client operating system, Atrust Linux, is hidden from the very beginning.

NOTE

« There are three similar but different modes for your t180L/t180LB and only one
mode will take effect if all are enabled. Three modes and the order of priority are
listed as follows:

5/

No. Mode Description

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection ¢, hection screen after system startup.

« For more information on these modes, please refer to sections:

< 4.2.9 on page 54 and 3.1 on page 19 (Quick Connection mode)
4.2.7 on page 50 (Appliance mode)

4.6.5 on page 131 (Autostart mode for RDP sessions)

4.6.11 on page 169 (Autostart mode for ICA sessions)

R

4.6.14 on page 202 (Autostart mode for View sessions)
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Enabling the Appliance Mode
To enable the Appliance mode, please do the following:

S NOTE
- Ensure that you have configured the connection settings for the desired Microsoft
Remote Desktop, Citrix ICA, VMware View or Horizon View session under
Applications tab. You need to specify which service type and connection settings
entry will be used under the Appliance mode. For detailed instructions, please see

sections:
< "4.6.3 Configuring Basic RDP Connection Settings” on page 116

< "4.6.6 Configuring Basic ICA Connection Settings” on page 146
< "4.6.12 Configuring Basic VMware View Connection Settings” on page 198

NOTE
+ Please note that the Autostart mode also enables the client to start up directly with
an RDP / ICA / View session and provides more configuration flexibility than the
Appliance mode. For detailed information on the Autostart mode, please refer to

the following sections:
< "4.6.5 Configuring Advanced RDP Connection Settings” on page 131
< "“4.6.11 Configuring Advanced ICA Connection Settings” on page 169
< "4.6.14 Configuring Advanced View Connection Settings” on page 202

i)

1. On Atrust Client Setup, click System > Appliance Mode.

®) Atrust Client Setup wlolol
Atl'l.lSt Applicati User Interf: Devices Network System
Time Zone
- Password r Basic Settings
~ Firmware Update Enable Appliance Mode
Appliance Mode = PP
Auto Setup b
- Quick Connection 7] ]
- Terminal | Save | | Cancel |

- Error Report
- Certificate Manager

2. Click to check Enable Appliance Mode.
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3. Other settings of the Appliance mode appear.

- Basic Settings
h.. + Enable Appliance Mode

Application Type:

[citrix Ica -
Use Session: [xD -l E
On Application Exit: | Shutdown - I-
* o launch Console: Shift+ Ctri+Delete

* To minimize ICA Fullscreen Desktop: Press Left Ctri+F2 then Alf+F9

4. Click drop-down menus to select the application (or service) type: Citrix ICA, Remote Desktop, or
VMware View, the specific service available in that type, and the desired action after exiting a session.

~ Basic Settings
. ¥ Enable Appliance Mode

Application Type:

[ citrix 1ca -
Use Session: |XD h |_
On Application Exit: | Shutdown hd |_
* o launch Console: Shift+Ctri+Delete

* To minimize ICA Fullscreen Desktop: Press Left Ctri+F2 then Alf+F9

- Basic Settings

h-. + Enable Appliance Mode
Application Type:

[Remote Desktop -
Use Session: [wns -l &
On Application Exit: | Shutdown - I-
* o launch Console: Shift+ Ctri+Delete

*To toggle RDP fullscreen: Ciri+Aff+Enter

-~ Basic Settings

h.. + Enable Appliance Mode
Application Type:

|VMware Wiew -
Use Session: [vHv -l E
On Application Exit: | Shutdown - I‘
*To launch Console: Shift+ Ctri+Delete

*To release keyboard and mouse from the virtual desktop, press Cirl+Alt

% NOTE

+ No matter which Resolution option you choose for the selected RDP / ICA / View
service, RDP / ICA / View sessions under the Appliance mode will always use the
Full Screen mode to display the remote/virtual desktop.

5. Click Save to confirm your selections.
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6. The system will enter the Appliance mode after restart.

—=)») NOTE
7
- To disable the Appliance mode or to access Atrust Client Setup under the Appliance
mode, please refer to “Disabling the Appliance Mode” on page 53.

Disabling the Appliance Mode

To disable the Appliance mode, please do the following:

1. Under the Appliance mode, exit the Full Screen mode of the RDP / ICA session, or release the keyboard and

mouse from the View session (virtual desktop):

To exit the Full Screen mode of the RDP session, press Ctrl + Alt + Enter, and then minimize
the session window.

To exit the Full Screen mode of the ICA session, press Ctrl + F2, and then Alt + F9.

To release the keyboard and mouse from the View session (virtual desktop), press Ctrl + Alt.

%/ NOTE

+ Please note that the View session (virtual desktop) will remain on the background
after you release the keyboard and mouse from the View session (virtual desktop).

2. Click Ctrl + Shift + Del to launch Atrust Client Setup.

NOTE

i)

+ You cannot access the Taskbar of the client operating system (Atrust Linux) under
the Appliance mode.

3. On Atrust Client Setup, click System > Appliance Mode.

4. Click to uncheck Enable Appliance Mode, and then click Save to apply the change.
5. Return to the current RDP / ICA / View session:

+ To return to the current RDP / ICA session, use Alt + Tab (press and hold Alt, and then press Tab to switch
between different items) to select and restore the current RDP / ICA session.

To return to the current View session, click any place of the View session (virtual desktop)
on the background.

6. Log off from the current RDP / ICA /View session.

7. The client will shut down then. Restart your client manually.
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4.2.8 Enabling or Disabling Auto Setup

Auto Setup allows your thin client to get its preset configuration on startup and enter the desired user environment
automatically. Its operation requires Auto Setup environment and network connectivity, except for Auto Setup on
the client side. For details, please refer to User’s Guide for Auto Setup.

NOTE

- To disable Auto Setup after your thin client got its preset configuration, reset your
client. Please refer to “A.1 Resetting Your t180L/t180LB to the Factory Default” on
page 213.

5/

4.2,9 Configuring the Quick Connection Mode

The Quick Connection mode enables you to enter the Atrust Quick Connection screen after system startup.
This setting is enabled by default.

NOTE

« For detailed instructions on how to use your t180L/t180LB under the Quick
Connection mode, please refer to section “3.1 Learning the Basics” on page 19.

5/

+ There are three similar but different modes for your t180L/t180LB and only one
mode will take effect if all are enabled. Three modes and the order of priority are
listed as follows:

No. Mode Description

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop
e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.
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%‘ NOTE

—

- To use the Quick Connection mode, ensure that both the Appliance and Autostart
modes are disabled. By default, your t180L/t180LB is in the Quick Connection mode,
and both the Appliance and Autostart modes are disabled. However, if either of two
modes are enabled, the Quick Connection mode will fail to work.

- For more information on the Appliance mode, please refer to section“4.2.7 Enabling
or Disabling the Appliance Mode” on page 50.

« For more information on the Autostart mode, please refer to the following sections:

< "4.6.5 Configuring Advanced RDP Connection Settings” on page 131
< “4.6.11 Configuring Advanced ICA Connection Settings” on page 169
< "4.6.14 Configuring Advanced View Connection Settings” on page 202

To enable/disable the Quick Connection mode, please do the following:

1. On Atrust Client Setup, click System > Quick Connection.

®) Atrust Client Setup sellal Lol
Atrust Applications  User Interface Devices Network System
- Time Zone
- Password - Basic Settings )
Firmware Update . ¥ Enable Quick Connection after Power-up ‘

- Appliance Mode

- Auto Setup
Quick Connection

« Remote Desktop Option y
L. ¥ Multimedia Redirection ‘

-~ Terminal
~Error Report
- Certificate Manager ¢ Citrix ICA Option

.. ¥ Client Rendering

. ¥ HDX RealTime WebCam

L. ¥ Use H264 Compression

e Redirect Connected USB Devices

*All connected USE devices will be redirected unless more specific settings are
specified below:

* Enabling USE Redlirection on the server side is also reguired for this feature.

Use of USB Storage Devices: [Mapping -l

Use of USB Printers: |Mapping ;l =]

Plugged USB Devices:

(vendor: 046d Product: ¢31d) Logitech, Inc. Media Keyboard K200

Save ] | Cancel

2. Click to check/uncheck Enable Quick Connection after Power-up to enable/disable the Quick Connection
mode, and then click Save to apply the change.

%\ NOTE

—

- For advanced Quick Connection settings, please refer to the next section (4.2.10).
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3. Switch shortcuts are also added to or removed from the START menu and local Linux desktop as
shown below.

2 Atrust Quick Connectio
[« Settings
@ Log Out

Atrust

4.2.10 Configuring Advanced Quick Connection Settings

You are allowed to configure advanced Quick Connection settings for Remote Desktop, Citrix ICA, and
VMware View sessions through System > Quick Connections on Atrust Client Setup.

Advanced Quick Connection Settings for Remote Desktop Sessions
To configure advanced Quick Connection settings for Remote Desktop sessions, please refer to the table below:

~ Remote Desktop Option
g «| Multimedia Redirection

Remote Desktop Option

Item Description

Check/Uncheck to enable/disable multimedia redirection.

When enabled, the client receives original compressed multimedia streams and
decodes locally for display. This feature increases the load on the client, but
saves server resources, decreases the bandwidth usage, and improves audio and
video playback experiences.

Multimedia Redirection

It's enabled by default.
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Advanced Quick Connection Settings for Citrix ICA Sessions

To configure advanced Quick Connection settings for Citrix ICA sessions, please refer to the tables below:

« Citrix ICA Option
. [¥| Client Rendering

. ¥/ HDX RealTime WebCam

L. | | Use H264 Compression

Citrix ICA Option

Item Description

Check/Uncheck to enable/disable client rendering.
Client Rendering

When Client Rendering is disabled, Server Rendering is used.

This item is available only when Client Rendering is selected.
HDX RealTime WebCam

When Yes is selected, a locally attached webcam can be used in an ICA session.

. Check to enable H.264 compression support on the client, allowing session data
Use H264 Compression . - .
are sent from the server side using H.264 format encoding.

ke Redirect Connected USB Devices

* All connected USB devices will be redirected unless more specific settings are
specified below,

* Enabling USB Redirection an the server side is also required for this feature.

Citrix ICA Option

Item Description
Redirect Connected Check to enable redirection for connected USB devices in Quick Connection
. mode. All connected USB devices will be redirected unless more specific settings
USB Devices .
are specified below.

UUse of USB Storage Devices: |Mapping ;l =

Use of USB Printers: [Mapping ~1 [

Citrix ICA Option

Item Description

. Click to select how to use USB storage devices in ICA sessions. Three options are
Use of USB Storage Devices available: Mapping, Redirection, and Disabled.

Use of USB Printers Click to select how to use USB printers in ICA sessions. Three options are
available: Mapping, Redirection, and Disabled.
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Plugged USB Devices:

(Wendor: 046d Product: c52e) Logitech, Inc.

Redirection Rules:

*® Use redirection rules fo manage specific USE devices.

* Maximum number of rules: 10

vendor o [ productio [ ] ado

Citrix ICA Option

Item

Description

Redirection Rules

Create redirection rules on 9 to manage specific USB devices with information on 0

T—i'/ NOTE

« All attached USB devices will be listed under Plugged USB Devices (o) with vender
and product information needed for creating rules.

Advanced Quick Connection Settings for VMware View Sessions
To configure advanced Quick Connection settings for VMware View sessions, please do the following:

1.

~ Password

- Terminal
-~ Error Report

- Firmware Update
- Appliance Mode

Auto Setup
Quick Conneaction

Certificate Manager

On Atrust Client Setup, click System > Quick Connection.

.. ¥ Use H264 Compression
e Redirect Connected USB Devices

* Enabling USE Redlirection on the server side is also reguired for this feature.
Redirection has priority over Mapping.

¢« VMware View Option

Mass Storage: [Enabled B
Smart Card: [Disabled =] e
Human Interface Device: [Disabled -] E
Printer: [Enabled -] e

Plugged USB Devices:
(Vendor: 046d Product: c52e) Logitech, Inc.

Redirection Rules:
* Use redirection rules to manage specific USE devices.

* Maximum number of rules: 10

vendorio: [ productio [ aas

Save H Cancel l

Atrust Client Setup Ll X
Atl'l.lSt Applicati User Interf: Devices Network System
Nav General
- Time Zone L Y Nn BESTIE WELLE o

/@
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2. Click drop-down menus to configure Generic Settings (0) for mass storage devices, smart cards, human
interface devices, and printers. Two options are available: Enabled or Disabled.

Mass Storage: [Enabled -] e
Smart Card: [ Disabled | e
Human Interface Device: [ Disabled -] e
Printer: [Enabled -] e

3. Use Redirection Rules (e) to manage specific USB devices:

Plugged LISB Devices: 9
(vendor: 046d Product: ¢S52e) Logitech, Inc,

Redirection Rules: e
¥ Use redirection rules to manage specific USE devices.

* Maximum number of rules: 10

vendor ID: | | Product ID: | Add

- Referto (9) to fill in the Vender and Product IDs for a specific device, click the drop-down menu to select
Allow or Deny.

« Click Add on the right to add a rule on (9).

NOTE

0

« All attached USB devices will be listed under Plugged USB Devices (9) with vender
and product information needed for creating rules.

* Redirection Rules (9) have priority over Generic Settings (o).

4. Click Save to apply.
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4.2.11 Enabling or Disabling the Command-line Functions

To enable/disable the execution of the text-based (command-line) functions, please do the following:
1. On Atrust Client Setup, click System > Terminal.

®) Atrust Client Setup

Atl'l.lSt Applicati User Interf: Devices Network System

- Time Zone
- Password - Basic Settings
- F\rmv_vare Update E Enable
- Appliance Mode

- Auto Setup b

- Quick Connection |?] |m.

~Error Report
- Certificate Manager

2. Click to check/uncheck Enable to allow/disallow the execution of the command-line functions.
3. Click Save to confirm your change.

4. The shortcut appears/disappears on the Start menu for access.

. Atrust Client Setup
a Mixer
& Power Resurme Manager

W System Information
Bl Terminal

%J‘ NOTE

+ On the local Linux desktop, click START > Settings > Terminal to open the
Terminal window.
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4.2.12 Collecting Event Logs and Capturing Related Screens

The Error Report feature allows you to collect event logs and capture related screens for error reporting.

Collecting Event Logs
To collect event logs of your t180L/t180LB, please do the following:

1. Plug a USB flash drive into your t180L/t180LB.

?—%' NOTE
— « This USB flash drive will be used for storing the event logs of your t180L/t180LB.

- Ensure that you have enabled the access and automount of USB storage devices.
For detailed instructions, please refer to section “4.4.3 Configuring Settings for USB
Storage Devices” on page 82.

NOTE

allt]

- Please note that files saved on the local desktop will be deleted after restart.

2. On Atrust Client Setup, click System > Error Report.

® Atrust Client Setup AN FSRIRER B

Atl'l.lSt Applicati User Interf: Devices Network System

- Time Zone
- Password - Collect Log
- Firmware Update Collect event logs to USB storage for troubleshooting.
- Appliance Mode

Auto Setup Please send the Error Report file to your administrator,
-~ Quick Connection
- Terminal

Certificate Manager
- Advanced

Collect Log

~ Launch Screenshot

Execute a screenshot tool to capture your screen.

Launch Screenshot

- Upload Files

FTP Server Address: o | =
FTF Username: | ‘ e
FTP Password: [ | =

Upload Check

Back
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3. Click Collect Log. A window appears prompting you to choose where to save the log file set (named
events.tar.gz). The attached USB flash drive is the default location if attached. Click Save to apply.

o e
- save Archive file to s
Lookin:  [[Ey/media/mooT e 4B E
g Co... efi
user firmware
BOOT install. 386
Fie name: [ ENCHERETEE [ Fisae |

Files of type: [Archwe Files (*tar.gz)

e

Capturing Error-Related Screens
To capture error-related screens of your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click System > Error Report.

2. Click Launch Snapshot to open the screen capturing program.

- Screenshot

Screenshot
Take a screenshot

Region to capture

Delay before capturing

seconds

1 Entire screen

windowf
o}

region

[1 Capture the mouse pointer

3. Configure screen capturing settings directly on the opened window if needed, and then click OK to capture
the desired screen.

@

TIP

« It's recommended to set the delay time before capturing to at least 2 seconds to
reserve time for switching to the desired screen or window.

« It's recommended to save the captured screens in the same USB flash drive where
the event logs were saved.

« Please note that files saved on the local desktop will be deleted after restart.
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4.2.13 Uploading Files for Error Reporting

You can upload files to a specified FTP server for error reporting.
To upload files to an FTP server, please do the following:

1. On Atrust Client Setup, click System > Error Report.

. EEEE
® Atrust Client Setup o alliCS
Atl'l.lSt Applicati User Interf: Devices Network System
- Time Zone
.- Password ¢ Collect Log
- Firmware Update Collect event logs to USB storage for troubleshooting.
- Appliance Mode
- Auto Setup Please send the Error Report file to your administrator.
-~ Quick Connection
- Terminal
I
- Certificate Manager Collect Log
~Advanced -
¢ Launch Screenshot
Execute a screenshot tool to capture your screen,
Launch Screenshot
- Upload Files
FTP Server Address: [ | =
FTP Username: [ =
FTP Password: [ | .__
Upload Check
Back

2. Under the Upload Files section, type the IP address of the FTP server and credentials, click Upload to select
and upload files to that FTP server.

- Select files for upload Gl

Look in: [Ihome}user 3] {*}El E-:'} 5 ] @
user Desktop

Documents

Music

Fictures

Public

Templates
Videos

File name: [ l 'E?gpen

Files of type: [Archlve Files (*.tar.gz) H l

+ You can check the validity of the IP address and credentials first through the
Check button.
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4.2.14 Importing Certificates for Remote Computers

You can import certificates for remote computers through:

« Alocal device (from a USB storage device)

«  The network (from a remote computer or the management console)

NOTE

+ The available management console for t180L/t180LB is Atrust Device Manager,
a remote and group management console for multiple thin clients. For more
information, please refer to the User’s Manual for Atrust Device Manager.

i

Importing certificates through a USB storage device
To import certificates for remote computers through a USB storage device, please do the following:

1. Copy your certificates to a USB storage device, and then connect this storage device to your t180L/t180LB.
2. On Atrust Client Setup, click System > Certificate Manager.
3. Click Add on the top of the Certificate list.

® Atrust Client Setup AN FERIRER
Atl'l.lSt Applicati User Interf: Devices Network System
o TR
Time Zone Issuedto % Issued by Expired on Valid Imported from

- Password

-~ Firmware Update

- Appliance Mode
Auto Setup

- Quick Connection

-~ Terminal

- Error Report
Certificate Manager




4. In the From File section, click Browse to locate the desired certificate file, and then click Open to confirm.

Navi

Atrust

- Time Zone

~ Password

- Firmware Update
-~ Appliance Mode

Auto Setup

- Quick Connection
-~ Terminal

Certificate Manager

Atrust Client Setup AR
Applications User Interface Dervices Network System.
General
¢ From File

Configuring Client Settings
Configuring System Settings

Specify the file you want to import {up to 16 certificates in total, including those from
servers).

File Name: | Browse... Import

Note: Please select PEM or DER format certificate from your USB storage device,

~ From Server

Enter the IP address / URL/ FQDN of the server where you want to get the certificate(s),
and then click Import (up to 16 certificates in total, including those from files).

IP address / URL/ FQDN: | || mpert

- From Atrust Device Manager

Click Import to get the certificate(s) from the Atrust Device Manager.

Import
Cancel
5. Click Import to start importing the certificate.
6. On completion, the certificate is shown in the Certificate list.
®) Atrust Client Setup Lo
Atrust Applications  User Interface Devices Network System.
>.--.---ina”;§v;zoorge Issued to ¥ Issued by Expired on

- Firmware Update
-~ Appliance Mode
- Auto Setup

- Quick Connection

Terminal
rror Report

Certificate Manager

tarfield Root Certificate Authority - G2 Microsoft Code Verification Root 2021-04-15
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Importing certificates from remote computers through the network
To import the certificate from a remote computer through the network, please do the following:
1. On Atrust Client Setup, click System > Certificate Manager.
2. Click Add on the top of the Certificate list.
3. Inthe From Server section, type the IP address / URL / FQDN of the remote computer, and then click Import.

®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Devices Nemwork System
-~ Time Zone
- Password ¢ From File
~ Firmware Update Specify the file you want to import (up to 16 certificates in total, including those from
-~ Appliance Mode servers).
- Auto Setup
- Quick Connection File Name: I | Browse... Import
Terminal
~ Error Report Note: Please select PEM or DER format certificate from your USB storage device,
Certificate Manager
¢ From Server

Enter the IP address / URL / FQDN of the server where you want to get the certificate(s),
and then click Import (up to 16 certificates in tetal, including those from files).

IP address / URL / FQDN: |wwwgoog\e.com | Import

» From Atrust Device Manager

Click Import to get the certificate(s) from the Atrust Device Manager.

Import
Cancel ]
4. On completion, the certificate is shown in the Certificate list.
L] Atrust Client Setup AR F=H RER X
Atl'l.lSt Applicati User Interf: Devices Network System
-inar;:vvzoorge Issued to ¥ Issued by Expired on valid Impo
GeoTrust Global CA Equifax Secure Certificate Authority 2018-08-21 “alid Serve

-~ Firmware Update

- Appliance Mode
Auto Setup

- Quick Connection

- Terminal

- Error Report
Certificate Manager
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Importing certificates from Atrust Device Manager through the network
To import certificates from Atrust Device Manager through the network, please do the following:

NOTE

- Before proceeding, ensure that (1) your thin client has been added into a managed
group in the management console, that is, Atrust Device Manager, and that (2) you
have imported certificates into the management console.

% ‘

1. On Atrust Client Setup, click System > Certificate Manager.
2. Click Add on the top of the Certificate list.

3. Inthe From Atrust Device Manager section, click Import to start importing all certificates available in
Atrust Device Manager.

4. On completion, the certificates are shown in the Certificate list.

®) Atrust Client Setup o =llCS
Atrust Applications  User Interface Devices Network System
O -
'__'__;iaw;gfoorge Issued to + Issued by Expire
Firmware Update Go Daddy Secure Certificate Authority - G2 Go Daddy Root Certificate Authority - G2 2031-
Starfield Root Certificate Autherity - G2 Microsoft Code Verification Root 2021-

- Appliance Mode
- AEFU Setup Starfield Secure Certificate Authority - G2 Starfield Root Certificate Authority - G2 2031-
- Quick Connection

Terminal

- Error Report
Certificate Manager
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4.2.15 Enabling or Disabling Auto Registration

Auto Registration allows that thin clients automatically register with Atrust Device Manager when they are online
and then become managed by Atrust Device Manager.

NOTE

- For this feature to work, Auto Registration must be enabled on both sides: thin
clients and target Atrust Device Manager. In addition, some configurations on
DHCP or DNS server over your network are required. For details, please refer to the
User’s Manual for Atrust Device Manager.

=

- By default, Auto Registration is enabled on thin client side, disabled Atrust
Device Manger.

To enable or disable Auto Registration on your thin client, please do the following:

1. On Atrust Client Setup, click System > Advanced.
2. Check/ Uncheck to Enable Auto Registration to enable / disable Auto Registration.

® Atrust Client Setup G Lkl
Atl'l.lSt Applicati User Interf: Devices Network System

Time Zone

- Password - Auto Registration

-~ Firmware Update

- Appliance Mode
Auto Setup

-~ Quick Connection e [

- Terminal | Save ] | Cancel |

~ Error Report

- Certificate Manager

.. ¥ Enable Auto Registration

3. Click Save to apply.



4.3 Configuring User Interface Settings

4.3.1

User Interface tab enables you to configure settings for the user interface of clients. To access available settings of

User Interface Tab Overview

User Interface tab, click the tab on Atrust Client Setup.

Configuring Client Settings
Configuring User Interface Settings

User Interface Tab Overview

Atrust

0............@.Display

Interface Elements

No.

' Screensaver

Atrust Client Setup

Applications User Interface Devices

I- Display
Configure display settings

Network System

scee

" Desktop
~—— Configure desktop settings

) Keyboard
S Configure keyboard settings

" Mouse
Configure mouse settings

- Screensaver
= Configure screensaver settings

Name

Description

1

Navigation area

Click to select a setting item under User Interface tab.

2

Configuration area

Configures setting values when a setting item or entry is selected.
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Configuring User Interface Settings

4.3.2 Available Settings at a Glance

Tab Setting Icon
Display ﬁ-,
Desktop I A
—
User Interface Keyboard ;:.;.
Mouse

Screensaver EE:

=

4.3.3 Configuring Display Settings

To configure display settings for your t180L/t180LB,

Description

Click to configure display settings.

Click to customize desktop and system language.

Click to adjust keyboard settings.

Click to adjust mouse settings.

Click to configure screensaver settings.

please do the following:

1. On Atrust Client Setup, click User Interface > Display.

® Atrust Client Setup | =W | NN [
Atl'l.lSt A User Interf: Devices Network System
Navigator General
Displa
- Desktop ¢ Display
- Keyboard Number of Display: | 2 hd I =
- Mouse
- Screensaver Display Layout: [(Dv4 - DvI-D) horizontal 1o
Display Mode: |Extend e

¢ Monitor Settings

Monitor-1 (DVI-I)
Resolution:
Rotation:
Monitor-2 (DVI-D)

Resolution:

Rotation:

L. ¥ Enable Autc-Detection at Powerup

[auto

[Mormal

[Aute (1920x1080)

[Normal

Save

H Cancel J

Section

4.3.3

Pl
www
ou s

4.3.7

4.3.8

4.3.9

Page
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77
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2. Click drop-down menus to select the number of attached display(s), arrangement of displays, resolution, etc.
Refer to the following table to select appropriate setting values.
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« The available setting items vary, depending on your model and the selected
number of display(s).

Display

Item

Description

Number of Display

Click to select the number of attached display(s).

Option Description
1 One display is attached.
2 Two displays are attached.

Display Layout

Click to select the arrangement of displays.

Option Description
Use DVI-1 Use the single display that is attached to the DVI-I port.
Use DVI-D Use the single display that is attached to the DVI-D port.

Use dual displays.

Two displays are arranged horizontally:

the DVI-I one is on the left; the DVI-D the right.

The DVI-I one is the main display for local desktop when
Extend is selected.

(DVI-I - DVI-D)
horizontal

Use dual displays.

Two displays are arranged horizontally:

the DVI-D one is on the left; the DVI-I the right.
The DVI-D one is the main display for local desktop
when Extend is selected.

(DVI-D - DVI-I)
horizontal

Use dual displays.

Two displays are arranged vertically:

the DVI-I one is on the top; the DVI-D the bottom.

The DVI-I one is the main display for local desktop when
Extend is selected.

(DVI-I - DVI-D)
vertical

Use dual displays.

Two displays are arranged vertically:

the DVI-D one is on the top; the DVI-I the bottom.
The DVI-D one is the main display for local desktop
when Extend is selected.

(DVI-D - DVI-I)
vertical

Display Mode

This item is available only when 2 is selected in the Number of Display drop-
down menu:

Option Description

Extend One display is used as the extended display of the other.

Clone Two displays have the same display content.
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Monitor Settings

Item

Description

Enable Auto-Detection at
Power-up

Check/Uncheck to enable/disable the automatic detection of the attached
monitor(s) when the client is powered on.

Option Description

Automatic detection of the attached monitor(s) is enabled.
Enabled The system would set an appropriate resolution for the
attached monitor(s) when the client is powered on.

Automatic detection of the attached monitor(s) is disabled.
All resolutions supported by the client will be listed in the

Disabled Resolution drop-down menu when Auto-Detection at
Power-up is disabled. Please note that some resolutions
may not be applicable to your monitor(s).

Monitor Resolution

Use this item to set an appropriate resolution for the attached display.

Option Description

This option is available only when Enable Auto-Detection
Auto ]

at Power-up is selected.
Other Select the desired resolution from the Resolution drop-down
options menu for the attached display.

NOTE: All resolutions supported by the client will be listed in the Resolution
drop-down menu when Auto-Detection at Power-up is disabled.
Please note that some resolutions may not be applicable to
your monitor(s).

i)

NOTE

+ When the vertical Display Layout and Extend display mode are selected, the Taskbar
will be moved to the top of the main desktop as shown below.
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4.3.4 Customizing Desktop and System Language Settings

To customize desktop and system language settings for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

Atrust

Navigator

- Displa
Desktop

- Keyboard

- Mouse

- Screensaver

Atrust Client Setup

Applicati User Interf: Devices Network System

General

¢ System Language
Language: |Eng|\sh

This setting will take effect after reboot.

- Desktop Fonts

Default Font: [sans
Default Font Style: |Regu\ar
Default Font Size: [12

Title Font: [sans
Title Font Style: |Regu\ar
Title Font Size: [1z

- Desktop lcons
E Remote Desktop

e Citrix

[ VMware View

lcon Size: |32
Icen Font Size: |10
Save ] | Cancel

2. Click drop-down menus or tick/untick checkboxes to choose desired settings. Refer to the following table for

a description of each setting item.

System Language

Item

Description

Language

Click the drop-down menu to select the system language.

NOTE: Available languages may vary with the firmware version of your device.
NOTE: You need to restart the system for the change to take effect.

Desktop Fonts

Item

Description

Default Font

Default Font Style

Default Font Size

Click the drop-down menus to select the desired font, its style and size used for
the user interface of the operating system, such as menus, options on menus,
text labels for desktop shortcuts, tabs on program windows etc.

NOTE: Your changes will not apply to the titles of opened windows, the Atrust
Client Setup console, and the System Information window (START >
System Settings > System Information).

Title Font

Title Font Style

Title Font Size

Click the drop-down menus to select the desired font, its style and size used for
the titles of the opened windows.
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Desktop Icons

Item

Description

Remote Desktop

-

Check/Uncheck to show/hide shortcuts Remote Desktop [ on the START

menu and local Linux desktop for service quick access.

For more information, please refer to section “4.3.5 Hiding or Showing Quick
Access Shortcuts” on page 75.

Citrix

Check/Uncheck to show/hide shortcuts Citrix on the START menu and local

Linux desktop for service quick access.

For more information, please refer to section “4.3.5 Hiding or Showing Quick
Access Shortcuts” on page 75.

VMware View

oda

Check/Uncheck to show/hide desktop shortcuts VMware View on the

START menu and local Linux desktop for service quick access.

For more information, please refer to section “4.3.5 Hiding or Showing Quick
Access Shortcuts” on page 75.

Icon Size

Click the drop-down menu to select the desired size of desktop icons/shortcuts.

Icon Font Size

Click the drop-down menu to select the desired text label size of desktop
icons/shortcuts.

Desktop Background

Item

Description

Enable Desktop Wallpaper

Check/Uncheck to enable/disable the use of Atrust wallpaper.

NOTE: If disabled, the solid color background (dark blue) will be used.

Enable Custom Wallpaper

Download From

Custom Wallpaper File

Check/Uncheck to enable/disable the use of a custom wallpaper. More settings
appear when checked.

For details, please refer to "4.3.6 Using a Custom Wallpaper” on page 76.

Wallpaper Style

Click the drop-down menu to select the way to apply the wallpaper. Five options
are available: Centered, Tiled, Stretched, Scaled, and Zoomed.

Option Description

Centered Centers the original image on the screen.

Tiled Tiles the screen with the original image.

Stretched Centers and extends/shrinks the image to fit the screen.

Scaled Cen_ters and sizes the image_propqrtionz_ally to fit the screen
until the top-bottom or left-right sides fit the screen.

Zoomed Centers and sizes the image proportionally to fill the screen.

NOTE: Depending on the size of the connected display, two options might have
the same effect.

Wallpaper

Click the drop-down menu to select the color of Atrust wallpaper. Four colors are
available: Green, Blue, Orange, and Cyan.

3. Click Save to apply.
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4.3.5 Hiding or Showing Quick Access Shortcuts

When the Quick Connection mode is disabled, the switch shortcuts Atrust Quick Connection on the START menu
and local Linux desktop will be hidden.

2 Atrust Quick Connectio

[s5 Settings

© Log Out Atrust

In case you want to access services quickly when the Quick Connection mode is disabled, you can choose to show
Quick Access shortcuts Remote Desktop / Citrix / VMware View on the START menu and local Linux desktop.
These shortcuts enable you to access services quickly when the Quick Connection mode is disabled. They're hidden
by default.

To show/hide shortcuts Remote Desktop / Citrix / VMware View on the START menu and local Linux desktop,
please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

Atrust Client Setup

Applicati User Interf: Devices Network System

General

r System Language
- Keyboard Language: [English d| e
~-Mouse

Screensaver This setting will take effect after reboot.

- Desktop Fonts

Default Font: [sans hd h.
Default Font Style; [Regular -l e
Default Font Size: [12 h ._
Title Font: [sans hd h.
Title Font Style: |Regu\ar hd Il
Title Font Size: 12 e

- Desktop lcons
e Remote Desktop

L [ Citrix

h.. VMware View

lcon Size: [32 R
Icon Font Size: [10 k| I.. |

Save H Cancel
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2. Click to check/uncheck Remote Desktop / Citrix / VMware View in the Desktop Icons section to show/hide

the quick access shortcuts Remote Desktop / Citrix / VMware View on the START menu and
local Linux desktop.

3. Click Save to apply the change.

4. The selected shortcuts will be shown/hidden.

®

WMware Vi..,

<+ Remote Desktop

@ Citrix

£ VMware View

[« Settings

@ Log Out Atrust

4.3.6 Usinga Custom Wallpaper
To use a custom wallpaper, please do the following:
1. On Atrust Client Setup, click User Interface > Desktop.

Atrust Client Setup

Atrust Applications  User Interface Devices Network System

General

1ItIe FONT STyle: |Reguiar
Title Font Size: [1z
- Screensaver ~ Desktop lcons

= Remote Desktop
h.. Citrix

[ VMware View

lcon Size: |32

Icon Font Size: [10

- Desktop Background

._._ +| Enable Desktop Wallpaper
h.. Enable Custom Wallpaper

Wallpaper Style: |Stretched

Wallpaper: |B\ue

| Save H Cancel ]
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2. Check or Uncheck Enable Custom Wallpaper to enable or disable the use of a custom wallpaper.

3. Select the way to apply the wallpaper and where to download or get the image file. Three options are
available to get the wallpaper: Auto Setup, Device Manager, and File.

NOTE

ol

- If Auto Setup is selected, your thin client must be in Auto Setup environment and
be well-configured for that environment. Please see “Enabling or Disabling Auto
Setup” on page 54 for more information.

- If Device Manager is selected, your thin client must be managed by Atrust Device
Manager. For details, please refer to the User’s Manual for Atrust Device Manager.

4. Provide other information if required.

=) NOTE
Z

- If File is selected, you need to specify where to get the image file locally, for
example, a locally attached USB flash drive.

« The maximum allowed size of a custom wallpaper file is 5 MB.

5. Click Save to confirm.

4.3.7 Adjusting Keyboard Settings
To adjust keyboard settings for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click User Interface > Keyboard.

" LEEEE
®) Atrust Client Setup o =llCS

Atl'l.lSt Applicati User Interf: Devices Network System

General

- keyboard
B Use Custom Keyboard Settings

- Screensaver keyboard Layout: | United States of America

keyboard Type: | System Default

NMumLock
.. ¥ Enable NumLock on Boot
Cursor

L. ¥ Show Blinking

Blink Delay 1300

Type Settings

Repeat Speed [0 |

[——

Repeat Delay [500 |

Save ] | Cancel
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2. Click drop-down menus, tick/untick checkboxes, or move sliders to choose desired settings. Refer to the
following table for a description of each setting item.

Keyboard

Item

Description

Use Custom Keyboard Settings

Check/Uncheck to enable/disable the use of custom keyboard settings.

NOTE: You are allowed to set the keyboard layout and type only when this
setting is enabled.

Keyboard Layout

Click the drop-down menu to select the desired keyboard layout.

Keyboard Type

Click the drop-down menu to select the desired keyboard type.

Enable NumLock on Boot

Check/Uncheck to enable/disable the NumLock key after system startup.

Show Blinking Check/Uncheck to enable/disable the cursor blinking (local desktop only).
Cursor
Blink Delay Move the slider to select the blink delay between each occurrence of cursor.
T Repeat Speed Move the slider to select the character repeat rate when a key is held down.
ype
Settings

Repeat Delay

Move the slider to select the character repeat delay between its each occurrence.

& TIP

+ Hang your mouse over the Up/Down arrow to quickly scroll up/down the Keyboard
Layout list.

I_ Up arrow

Y

Arabic

Arabic (AZERTY)

Arabic (AZERTY / digits)
Arabic (digits)

Arabic (QWERTY)

Arabic frwrm T s
Canada (French Dvorak)
Canada (French (legacy))
Canada (Multilingual)

Canada (Multilingual first part)
Canada (Multilingual second part)

-

Down arrow —I

- To fine-tune a setting value, click its slider, and then use the Right/Left key to
increase/decrease the value by 1 or the Page Up/Page Down key to increase/
decrease by 10.

3. Click Save to apply.
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4.3.8 Configuring Mouse Settings

To configure mouse settings for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click User Interface > Mouse.

Atrust

- Display
- Desktop
- Keyboard

- Screensaver

Atrust Client Setup

Applicati User Interf: Devices Network System

¢ Mouse

Button Order: [Right handed
Feedback

Acceleration [z |
Threshold [4 |
Save ] | Cancel ]

2. Click the drop-down menu or move sliders to choose desired setting values. Refer to the following table for a
description of each setting item.

Mouse

Item

Description

Button Order

Click the drop-down menu to switch mouse buttons for right-hand/left-hand use.

Acceleration

Move the slider to select the rate at which the mouse increases speed while moving.

Feedback
Threshold

Move the slider to select the moved distance (pixels) after which the mouse starts
to accelerate.
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4.3.9 Configuring Screensaver Settings

To configure screensaver settings for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click User Interface > Screensaver.

Atrust

- Display

- Desktop r Screensaver
- Keyboard L. ¥ Enable Screensaver
- Mouse
Display Mode: E
Display After (minute): 10 hd S

Atrust Client Setup | F2H FER P

Applicati User Interf: Devices Network System

E Enable Display Sleep Mode

Enter Display Sleep Mode after Screensaver (minute): =

e On Resume, Password Protect

Save H Cancel |

2. Click drop-down menus or tick/untick checkboxes to choose desired settings.

Screensaver

Item

Description

Enable Screensaver

Check/Uncheck to enable/disable Screensaver.

Display Mode

Click to select the display mode of the screensaver. Two options are available:
Blank and Logo.

Option Description
Blank Displays a black screen.
Logo Displays the Atrust floating logo.

Display After (minute)

Click to select the wait time for screensaver.

Enable Display Sleep Mode

Check to turn off (i.e. stop sending signals to) the display to maximize the
energy savings.

Enter Display Sleep Mode after
Screensaver (minute)

Click to select when to turn off (i.e. stop sending signals to) the display after
Screensaver starts.

On Resume, Password Protect

Check/Uncheck to resume with/without a password.

TIP

@

« While setting wait time for screensaver, you can hang your mouse over the Up/
Down arrow to quickly scroll up/down the Minute list.

3. Click Save to apply.
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4.4 Configuring External Device Settings

4.4.1 Devices Tab Overview

Devices tab enables you to configure settings for external devices of clients. To access available settings of Devices
tab, click the tab on Atrust Client Setup.

Devices Tab Overview
- s
® Atrust Client Setup Gillod LGS
Atrust Applicati User Interf: Devices Network System
aoc-ooocoocooéousa Storage
- Audio USE Storage e
- Printer Configure USE storage settings

Audi
Qul Ao

Configure audio device settings

. Printer
== srdd local and network printers

Interface Elements

No. Name Description

Click to select a setting item under Devices tab or to select a setting

1 Navigation area entry under a selected setting item.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4.4.2 Available Settings at a Glance

Tab Setting Icon Description Section
. ) . . 4.4.3
USB Storage 'LP Click to configure settings for USB storage devices. 4.4.4
. . I . . . . . 4.4.5
Devices Audio Q“' Click to configure settings for audio devices. 4.4.6
. d . . 4.4.7
Printer A Click to add local or network printers. 4.4.8

4.4.3 Configuring Settings for USB Storage Devices

To configure settings for USB storage devices, please do the following:

—=)») NOTE
5/
« To access locally attached USB storage devices in a local or virtual session, you need
to configure appropriate settings under this setting item.

1. On Atrust Client Setup, click Devices > USB Storage.

® Atrust Client Setup | =W | NN [
Atrust Applicati User Intert: Devices Network System
Navigator General
LSB Storage
- Audio + USB Storage
- Printer v Enable USB Storage

L. ¥ Enable Automount

* This setting will take effect after reboot.

Save H Cancel |

2. Tick/untick the checkboxes to choose the desired settings.
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Settings for USB Storage Devices

Item Description

Tick/Untick this checkbox to allow/disallow the access of USB storage devices.

NOTE: To use the locally attached USB storage devices in an RDP / ICA / View
session, the mapping of local USB storage devices must be enabled

in this session’s RDP / ICA / View connection settings. For detailed
Enable USB Storage instructions and more related settings, please refer to sections:

"4.6.5 Configuring Advanced RDP Connection Settings” on page 131
"4.6.11 Configuring Advanced ICA Connection Settings” on page 169
“4.6.14 Configuring Advanced View Connection Settings” on page 202

Tick/Untick this checkbox to enable/disable the automount of
USB storage devices.

NOTE: If this setting is disabled, users need to manually mount the attached
Enable Automount USB storage devices. For detailed instructions, please refer to section

“4.4.4 Manually Mount and Eject Attached USB Storage Devices” on page
83.

3. Click Save to save your change.

—=)») NOTE
i
- For your changes to take effect, you need to restart your system.

4.4.4 Manually Mount and Eject Attached USB Storage Devices

To mount/eject an attached USB storage device, please do the following:

NOTE

Wi

- If Enable Automount is checked (see section “4.4.3 Configuring Settings for USB

Storage Devices” on page 82), then an attached USB storage device will be
mounted automatically.

1. Right click the desktop icon of the attached USB storage device.

2. A popup menu appears.

& Open

Mount Velume

& Eject Volume

3. Click to select Mount Volume/Eject Volume to mount\eject the attached USB storage device.
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4.4.5 Disabling or Enabling Attached Audio Devices

To disable/enable attached audio devices, please do the following:

=

NOTE

If you disable locally attached audio devices, client users are not allowed to perform
audio playback or recording with these devices in an RDP / ICA / View session.

To perform audio playback or recording with local audio devices in an RDP / ICA /
View session, you need to enable locally attached audio devices here

(the Audio setting item under Devices tab) and configure audio related settings
in the RDP /ICA / View connection settings. For detailed instructions, please

refer to sections:

< “4.6.5 Configuring Advanced RDP Connection Settings” on page 131
< “4.6.11 Configuring Advanced ICA Connection Settings” on page 169
< "4.6.14 Configuring Advanced View Connection Settings” on page 202

1. On Atrust Client Setup, click Devices > Audio.

®) Atrust Client Setup o ol
Atrust Applicati User Interf: Devices Network System
Navigator General

Audio
- Printer

- USB Storage

-~ Audio
.. ¥ Enable System Audio Device

* This setting will fake effect after reboot.

| Save H Cancel |

2. Click to check/uncheck Enable System Audio Device.

3. Click Save to confirm your selection.

)

NOTE

- The change will not take effect until t180L/t180LB has been restarted.



Configuring Client Settings |85

Configuring External Device Settings

4.4.6 Using USB Audio Devices

By default, your thin client would use audio devices attached to 3.5 mm audio ports. In case that you want to use a
USB audio device, you need to change the default.

To configure default audio devices, please do the following:

1. Connect the desired USB audio device to your thin client.

2. On Quick Connection screen or local desktop, click ) icon in the bottom-right corner to open

the Mixer window.

4 Mixer i c)
Playback Device: [HDA Intel PcH
Capture Device: [HDA Intel PcH
Playback Capture
Headphone Capture
il

[+]

H

Save Close

3. On the opened window, click the drop-down menu to select the USB PnP device.

Example: Using USB Speakers

SEE———

Playback Device: HDA Intel PCH Playback Device: [USB PnP Sound Device % ]
) DisplayPort ) "
Capture Device: ; Capture Device: [HDA Intel PCH > ]
Playback Lapiure Playback Capture
Headphone Capture Speaker Capture
l‘ I I I
=) NoTE

S———

« The default for Playback and Capture devices is HDA Intel PCH. Available options
may vary with your thin client model.

4. Click Save to confirm.
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4.4.7 Adding aLocal Printer

To add a local printer for your t180L/t180LB, please do the following:

1. Connect the desired printer to your t180L/t180LB and turn on the printer.

2. On Atrust Client Setup, click Devices > Printer.

Atrust Client Setup e LS
User Interf: Devices Network System
+ Add || = Delete
~ USB Storage Printer Name % Printer URI Description
>....Aud|o

Printer

Click Add on the top of the Printer list.
The system automatically start searching for available local printers.

Upon completion, the discovered local printers will be listed on the Printer Port drop-down menu.

o v ok W

Click the Printer Port drop-down menu to select the desired local printer.

TCP Metwaork Printer
LPD Network Printer
IPP Metwork Printer
EPSON EPL-6200L

7. Fields in the Add Printer section will automatically change to fit the type of the selected printer.
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8. Afield for the selected printer appears and the printer URI (Uniform Resource Identifier) data is automatically

filled out in the field.

® Atrust Client Setup | =W | NN [
Atrust Applicati User Interf: Devices Network System
General
- USB Storage
- Audio ¢+ Add Printer
Printer Name * | \ [
[Prmter Fort: EPSON EPL-6200L 'I [
EPSON EPL-5200L * [serial=23P160612111836080] |
Description: | ‘ e
Manufacturer: [Generic hd il ™
Printer Model: | hd [ T
e Share Printer
. ¥ Mapping in RDP Sessions
L. ¥ Mapping in ICA Sessions
L. ¥ Mapping in VMware Sessions
Windows Driver Name [ | =
RDP Printer Mapping Name [ =
Save H Cancel

NOTE

(allh]

« A URI (Uniform Resource Identifier) is a sequence of characters that is used to
identify a resource on the Internet.

9. Click the Manufacturer and Printer Model drop-down menus to select the manufacturer and model for the
attached local printer.

—=)») NOTE
7/
- For the printer to operate normally, you need to specify the correct information in
these two menus. Otherwise, the printer would fail to work.

10. Refer to the following table to configure desired settings.

—=)») NOTE
=
+ You may need to provide the Windows driver name for your printer. For details,
please refer to descriptions in the table.

11. Type the desired printer name, and then click Save to apply.
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Settings for Printers

Item

Description

Share Printer

Check/Uncheck to share the printer.

Once Share Printer is checked, other computers in the same network segment
will be allowed to use the printer.

To add this shared printer for use on other computers, please do the following:

1. For computers running a Windows Server operating system, such as
Windows Server 2008 R2, please add the Internet Printing Client
feature first (Click Start > All Programs > Administrative Tools >
Server Manager > Action > Add Features > Internet Printing Client,
follow the wizard to complete the task, and then restart your system).

2. Click Start > Devices and Printers > Add a printer >
Add a network, wireless or Bluetooth printer.

3. Click Stop to cancel the automatic printer search, and then click
The printer that I want isn’t listed.

4. Under Select a shared printer by name, enter
http://IP address of your thin client:631/printers/Printer Name.

NOTE: For example, if a printer is locally attached to your thin client and is
added as a local printer through Atrust Client Setup with the printer
name EPS, and the IP address of your thin client is 192.168.50.146.
Here you should enter: http://192.168.50.146:631/printers/EPS

5. Click Next to continue.

6. Select the manufacturer and model of the printer, and then click OK to
install the correct driver.

7. Upon completion, a success message appears. Click Next to continue.
8. On the appeared page, click Print a test page to test the printer.
9. Click Finish to apply. The printer is added to the Printers and Faxes list.

Mapping in RDP Sessions

Check/Uncheck to enable/disable the locally connected printer in an RDP session.

Mapping in ICA Sessions

Check/Uncheck to enable/disable the locally connected printer in an ICA session.

Mapping in VMware Sessions

Check/Uncheck to enable/disable the locally connected printer in a View session.

Windows Driver Name

Keep this field blank, if the printer works well in a session. In case that the
printer fails to work, filling in this field may solve the problem.

To find out the required information, please do the following:

1. Attach the printer to a computer running a Windows OS, complete the
required installation, and ensure the printer works well.

2. Click Start > Devices and Printers, and then, in the opened window,
right click the printer to open a popup menu.

3. On the popup menu, click to select Printer properties.
4. In the opened window, click Advanced. The driver name is shown.

/=1 Epson EPL-6200L Properties ===

General | Sharng | Pots | Advanced | Color Management | Securty | Optional Settngs |

@ Always available

© Available from 00:00 : 00:00

Priority: 1

A}
Driver: Epson EPL-6200L = || | New Driver
J

RDP Printer Mapping Name
(for RDP sessions only)

Type in the desired printer name in a session (Windows desktop). If this field
remains blank, the name you typed in the Printer Name field will be used.
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To add a network printer for your t180L/t180LB, please do the following:

1.

Ensure that your t180L/t180LB is connected to the network and the desired network printer is turned on.

Click Add on the top of the Printer list.

2. On Atrust Client Setup, click Devices > Printer.
3.
4

. The system automatically starts searching for available local printers. Upon completion, the discovered local

printers will be listed on the Printer Port drop-down menu.

Click the Printer Port drop-down menu to select the desired network printer. Three types of network printers
are available: TCP Network Printer, LPD Network Printer, and IPP Network Printer.

TCP Network Printer
LPD Metwork Printer
IPP Network Printer

Fields in the Add Printer section will automatically change to fit the type of the selected printer.

Type in the IP address of the network printer in the TCP Printer Server, LPD Printer Server, or IPP URI field.

~ Add Printer
Printer Name

Printer Port:
TCP Print Server
TCP Port

Description:

“ | | &
[ TCP Network Printer e
“ | | &
[9100 | &
| | &

- Add Printer

Printer Name
Printer Port:
LPD Print Server

LPD Queue Name

Description:

“ | |
[LPD Network Printer e

- Add Printer
Printer Name

Printer Port:
IPP URI

Description:

| ||.

[1PP Network Printer e

| ||..

| | &

8. Click the Manufacturer and Printer Model drop-down menus to select the manufacturer and model for the

desired network printer.

9. Refer to the table on page 88 to configure other printer settings, and then click Save to apply.
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4.5 Configuring Network Settings

4.5.1 NetworkTab Overview

Network tab enables you to configure network settings for clients. To access available settings of Network tab, click
the tab on Atrust Client Setup.

Network Tab Overview

D e [ e
® Atrust Client Setup * R X

Atl'l.lSt Applicati User Interf: Devices Network System

eccoe

eeccccccccle
@cccccoe

VPN - Ethernet

Hosts Configure wired network settings

Host Name
Wireless

: e

- Proxy A

PN
onfigure VPN (Virtual Private Network) connection settings

7
oo

z

sts
Create the mapping of IP addresses to host names and aliases

l.; Host Name

Adjust the host name for your client

| Wireless
Configure wireless network settings

\f) Proxy
T Configure proxy settings for Web-based access to services

Interface Elements

No. Name Description

Click to select a setting item under Network tab or to select a setting

1 Navigation area entry under a selected setting item.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4,5.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
Ethernet L Click to configure wired network settings. e o
4.5.4 95
VPN -y Click to configure VPN (Virtual Private Network) 4.5.5 96
) connection settings and create a VPN connection. 4.5.6 100
Click to create the mapping of IP addresses to 4.5.7 101
Hosts =/ i the names of host servers and create the Failover =
= ) 4.5.8 103
Cluster list.
Network
Host Name l; Click to change the host name of your thin client. 4.5.9 105
4.5.10 106
Wireless . Click to configure wireless network settings and 4.5.11 107
' create a wireless connection. 4.5.12 108
4.5.13 111
Proxy f ‘_;r Click to configure proxy settings for Web-based 4.5.14 112

i access to services.
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4.,5.3 Configuring Wired Network Settings
The Ethernet setting enables you to configure the wired network settings for your t180L/t180LB thin client.

Enabling or Disabling the Ethernet Network Interface
To enable/disable the Ethernet network interface, please to the following:

1. On Atrust Client Setup, click Network > Ethernet.

2. Under Interface section, check/uncheck Enable to enable/disable the Ethernet network interface.

- Interface
a v Enable

- |IP Address
IP Type:

[ DHCP M

- DNS
DNS Type:

[Dynamic DNS {via DHCP)  ~] |

3. Click Save to apply.

Using a Dynamic IP Address
To use a dynamic IP address, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the IP address section, click the drop-down menu to select DHCP for the IP type field.

NOTE

i

- If DHCP is selected, the DHCP server over the network will automatically assign an IP
address to your t180L/t180LB thin client. This is the default setting.

3. Click Save to apply.

Using a Static IP Address

To use a static IP address, please do the following:

%‘/ NOTE

+ It's recommended to use a dynamic IP address for your t180L/t180LB thin clientin a
corporate network environment.

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the IP address section, click the drop-down menu to select Static IP for the IP type field.

3. The IP address, Subnet mask, and Gateway fields appear in the IP address section.
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®) Atrust Client Setup o Lol
Atfl.lSt Applicati User Interf: Devices Network System
Ethernet
PN - Interface
- Host
‘-“-“\:ireless ¢ IP Address ~
e IP Type: [Static IP -le
IP Address: [ | e
subnet Mask: | =
Gateway: * | ‘ e
ons
Search Domain: [ | e
Nameserver 1: | =
Nameserver 2: | ‘ e
: Wake On LAN :
‘ Wake On LAN: [Enabled hd IS
| Save H Cancel |
4. Typein the IP address, subnet mask, and gateway for your t180L/t180LB thin client.
- IP address
IP type: | static IP -]
IP address: = [192.168.12.88 |
Subnet mask: « [255.255.255.0 | &
Gateway: « [192.168.12.254 | &

% NOTE

- Consult your network administrator for a free IP address and other required data
about the network to which your t180L/t180LB connects. The red asterisks indicate
the required fields.

5. Click Save to apply.

%J’ NOTE

+ You need to further specify DNS server addresses manually if you choose to use a
static IP address.

Obtaining DNS Server Addresses Automatically
To obtain DNS Server addresses automatically, please do the following:

5/ NOTE

+ You cannot obtain DNS server addresses automatically through the DHCP server if
you choose not to get the IP address via the DHCP server.
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1. On Atrust Client Setup, click Network > Ethernet.
2. Under the DNS section, click the drop-down menu to select Dynamic DNS (via DHCP) for the DNS type field.
3. Click Save to apply.

Specifying DNS Server Addresses Manually
To specify DNS Server addresses manually, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.
2. Under the DNS section, click the drop-down menu to select Manual setting.

3. The Search domain, Nameserver 1, and Nameserver 2 fields appear in the DNS section.

NOTE

]

+ If you choose to use a static IP address for your t180L/t180LB thin client, then you
need to specify DNS server addresses manually. In this case, the DNS type field will
not appear for you to select Manual setting or Dynamic DNS (via DHCP).

®) Atrust Client Setup o =llCS
Atrust Applications  User Interface Devices Network System
Navigator General
Ethernet
YT ¢ Interface )
Hosts + Enable ‘
- Host Name =
‘-“-“\';\':geless ¢ IP Address )
W ‘ IP Type: [DHCP 1& ‘
- DNS
DNS Type: [Manual setting -l o
Search Domain: [ | =
Nameserver 1: [ =
Nameserver 2: | ‘ e
¢ Wake On LAN N
‘ Wake On LAN: [Enabled -] =
| Save ] | Cancel

4. Type in the preferred DNS server address in the Nameserver 1 field and the alternate DNS server address in
the Nameserver 2 field if any.

—=)) NOTE
i
« Specifying a domain name in the Search Domain field will enable your system to
discover a computer in that domain simply with its computer name rather than its
FQDN (Fully Qualified Domain Name).

5. Click Save to apply.
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4.5.4 Enabling or Disabling Wake On LAN

Your thin client supports Wake On LAN, enabling you to wake it up remotely with Atrust Device Manager, the client

management console developed by Atrust.
To enable/disable Wake On LAN, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.

® Atrust Client Setup o alliCS
Atrust Applicati User Interf: Devices Network System
Navigator General
Ethernet
YTy ¢ Interface )
- Hosts ¥ Enable ‘
- Host Name L = )
\Fn,\?geless ¢ IP Address .
Y ‘ IP Type: [DHCP 1o ‘
- DNS ~
‘ DNS Type: [Dynamic DS (via DHCP) — ~] [ ‘
- Wake On LAN )
‘ wake On LAN: [Enabled 1& ‘
| Save ] | Cancel

2. Click the drop-down menu to enable/disable Wake On LAN.

5/ NOTE

. It's enabled by default.
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4.,5.5 Establishing and Stopping a VPN connection

The VPN setting enables you to establish/stop a virtual private network connection for your t180L/t180LB.

NOTE

« The VPN setting also allows you to configure and manage virtual private network
settings. For instructions on how to configure and manage virtual private network
settings, please refer to section “4.5.6 Configuring Virtual Private Network Settings”
on page 100.

=

Adding a Virtual Private Network
To add a virtual private network, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

® Atrust Client Setup | =W | NN [
Atl'l.lSt Applications User Interface Devices Network System
Navigator Connections Seftings
- Ethernet
VPN + Add — Delete
- Hosts
- Host Name Connection Name VPN Type  Status Comment

- Wireless
- Proxy

NOTE

- If you haven't created any entry, the Virtual Private Network list will be empty.

]

2. Click Add on the top of the Virtual Private Network list.
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3. On General tab, click the drop-down menu to select the desired VPN type. Three types are available: PPTP,

L2TP, and Cisco AnyConnect.

Atrust

Navigator

- Ethernet
VPN

- Hosts

- Host Name

Wireless

- Proxy

- Connection Settings

Atrust Client Setup

Applications User Interface Devices

General Options

A FENI R B

System

Connection Name: * |

VPN type: [peTP

Server Address: *

- Login Settings

Username: * |

Password: <

Domain: [

- Security and Compression Setting

= Use Point-to-Point encryption (MPPE)

- Authentication Settings

= Enable PAP

e Enable CHAP

.. ¥ Enable MSCHAP
+ Fnahle MSCHAPw?

Save H Cancel

=)) NOTE
=

+ The setting items will vary with the selected VPN type.

4. Type in or click drop-down menus to provide information about configuration and authentication.

%‘/ NOTE

« Consult your network administrator for required information on configuration and
authentication.

5. On Options tab, configure the DNS-related settings if needed.

6. Click Save to add the virtual private network.

Establishing a Virtual Private Network Connection
To establish a virtual private network connection for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.
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®) Atrust Client Setup cilo LEL L
Atl'l.lSt Applications User Interface Devices Network System
Navigator Connections Settings

- Ethernet
VPN + Add = Delete
-~ Hosts
i rv?:élleusasme Connection Name VPN Type  Status Comment
- Proxy : ATSVPN PPTP Connected before

=)) NOTE
- If you haven't created any entry, the Virtual Private Network list will be empty. For
instructions on adding a virtual private network, please see the preceding topic.

2. Click to check the desired virtual private network. The Connect # Connect  putton then appears on the top
of the Virtual Private Network list.

® Atrust Client Setup silo LEL L
l\tl'l.ISt Applications User Interface Devices Network System
Navigator Connections Settings

- Ethernet
VPN + Add — Delete ~ Edit & Connect
- Hosts
:*V?rsetlzlgsme Connection Name VPN Type  Status Comment
~ Proxy o o ATSVPN PPTP Connected before

3. Click Connect to create a virtual private network connection through the selected network entry.



Configuring Client Settings
Configuring Network Settings

4. Upon completion, the Status column of the virtual private network will show connected.

® Atrust Client Setup | =W | NN [

Atl'l.lSt Applications User Interface Devices Network System
Navigator Connections Seftings

- Ethernet

VPN + Add — Delete
-~ Hosts
rv?rs;;":sme Connection Name VPN Type  Status Comment
ATSVPN PPTP connected Connected before, auto connect

- Proxy

Stopping a Virtual Private Network Connection
To stop a virtual private network connection, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network. The Disconnect /# Discennect pytton appears on the top of
the Virtual Private Network list.

3. Click Disconnect to stop the virtual private network connection.

Deleting a Virtual Private Network

To delete a virtual private network, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.
2. Click to check the desired virtual private network.

3. Click Delete to remove the selected virtual private network.
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4,5.6 Configuring Virtual Private Network Settings

Adjusting Connection settings for a Virtual Private Network
To adjust connection settings for a virtual private network, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network. The Edit .~ Edit  button appears on the top of the
Virtual Private Network list.

3. Click Edit to adjust the settings, and then click Save to apply.

Configuring General Settings for Virtual Private Network Connections
To configure general settings for virtual private network connections, please do the following:

1. On Atrust Client Setup, click Network > VPN, and then click Settings sub-tab.

® Atrust Client Setup | =R | FEN (S

Atrust Applications User Interface Devices Network System

Connections Settings

¢ Connection
= Auto connect when startup

Automatic VPN Connection: ATSVEN

Save Cancel

2. Under the Connection section, click to check/uncheck Auto connect when startup to allow/disallow
automatic virtual private network connection after system startup. When this feature is enabled, select the
desired virtual private network through the drop-down menu.
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4.,5.7 Creating the Mapping of IP Addresses to Names of Hosts

Atrust Client Setup allows you to use the name or alias of a host instead of its IP address wherever you need to
specify an IP address while configuring client settings. To use this feature, first you need to create the mapping of IP
addresses to names or aliases of hosts.

Creating the Mapping List
To create the mapping of IP addresses to names or aliases, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

®) Atrust Client Setup o+

Atru St Applications User Interface Devices Network System

Navigator | + Add H = Delete |

- Ethernet
Hosts
Host Name

~Wireless

- Proxy

Hostname ¥ IP Address Alias / Group Priority

2. Click Add to start adding a new host entry.
3. Typein the name, IP address, alias of a host, leave the Priority field blank, and then click Save to apply.

~ Hosts Table Settings

Hostname: * |WS2012R2RDSH | k&
IP Address: * [192.168.7.12 | &
Alias / Group: |ws12 | &
Priority. | | B

NOTE

=

- If your host belongs to a domain, please don't enter the FQDN (Fully Qualified
Domain Name) or full computer name in the Hostname field. Enter only the
computer name of the host in this required field.

+ You need to type a number in the Priority field only when creating a Failover Cluster
list to allow host failover feature. For details, please refer to “4.5.8 Configuring the
Failover Cluster List” on page 103.
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4. The newly added entry appears in the Host list.

® et R
® Atrust Client Setup | =W | NN [
Atrust Applications User Interface Derices Nemork System
Navigator | + Add H = Delete J
- hnet Hostname ¥ IP Address Alias / Group Priority
S WS2012R2RDSH WS2012R2RDSH 192,168.7.12  WS12 0
~-Host Name
Wireless
- Prowy

5. Repeat steps 2 through 3 to add another new entry.

6. Now you can use the name or alias of a host instead of its IP address wherever you need to specify an IP
address on Atrust Client Setup while configuring client settings.

Managing the Mapping List
To manage the Mapping list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

2. Select to manage entries on the Host list.

« To adjust the settings of an entry, double click the entry, or check off an entry, and then click the Edit
button on the top of the Mapping list.

« To delete an entry, check off the entry, and then click Delete on the top of the Mapping list.

+ To delete multiple entries, check off all the desired entries, and then click Delete. A window appears
prompting for confirmation. Click Yes to confirm.
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4,5.8 Configuring the Failover Cluster List

Atrust Client Setup allows you to create the Failover Cluster list, maintaining the high availability of services from
that group of servers (failover cluster).

Creating the Failover Cluster List
To create a Failover Cluster list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

®) Atrust Client Setup o+
Atru St Applications User Interface Devices Network System
Navigator | + Add H = Delete |
~ Ethernet Hostname ¥ IP Address Alias / Group Priority
Hosts
Host Name
- Wireless
- Proxy

2. Click Add to start adding a new host entry.

3. Typein the name, IP address, alias and also cluster (group) name, priority order in the cluster (group), and
then click Save to apply.

~ Hosts Table Settings

Hostname: * |ADM1 | B
IP Address: * [192.168.7.21 | &
Alias / Group: [ADM | &
Priority (1 | &

%J’ NOTE

« If your host belongs to a domain, please don’t enter the FQDN (Fully Qualified
Domain Name) or full computer name in the Hostname field. Enter only the
computer name of the host in this required field.
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4. Repeat steps 2 though 3 to add another new entry.
5. All added entries appear on the Host list.

®) Atrust Client Setup o =llCS
Atru St Applications User Interface Devices Network System
Navigator | + Add ” = Delete |
- hnet Hostname ¥ IP Address Alias / Group Priority
ADM1 ADM1 192.168.7.21  ADM 1
- ADM2 ADM2 192.168.7.22  ADM 2
ADM3 192.168.7.23 ADM 3

- ADM3
~-Host Name
Wireless

- Promy

6. Your t180L/t180LB will follow the given priority order while connecting to this failover cluster (group).

Hostname % IP Address Alias / Group Priority
ADM1 192.168.7.21 ADM 1
ADM2 192.168.7.22 ADM 2
ADM3 192,168,7.23 ADM 2

Managing the Failover Cluster List
To manage the Host list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

2. Select to manage entries on the Host list.

« To adjust the settings of an entry, double click the entry, or check off an entry, and then click the Edit
button on the top of the Host list.
« To delete an entry, check off the entry, and then click Delete on the top of the Host list.

- To delete multiple entries, check off all the desired entries, and then click Delete. A window appears
prompting for confirmation. Click Yes to confirm.
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4.5.9 Changing the Host Name of Your Thin Client

To change the host name of your thin client, please do the following:

1. On Atrust Client Setup, click Network > Host Name.

2. Change the default host name of your thin client.

®) Atrust Client Setup o ol

Atrust Applications User Interface Devices Network System

General

- Ethernet

-~ Hosts MName Setting

Host Name Host Name # [atrust-00C42F] | &
- Wireless
- Proxy * This setting will take effect after reboot.

Save Cancel

3. Click Save to confirm.

4. Arestart is required for the change to take effect.
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4.5.10 Enabling or Disabling the Wireless Interface

To enable or disable the wireless interface, please do the following:

NOTE

- By default, the wireless interface is enabled. But before you can access available
wireless networks, you need to install an external and USB-based wireless network
adapter for your t180L. Ensure that you have set up the required adapter.

=

+ Your t180L package may not include a wireless network adapter (optional). Please
contact your dealer for compatible adapters if needed. It's recommended to check
with your dealer first if you plan to purchase one by yourself.

1. On Atrust Client Setup, click Network > Wireless, and then click Wireless sub-tab.

& - CllElEEE
] Atrust Client Setup =
Atl'l.lSt Applicati User Interf: Devices Network System
Connections Wireless
Ethernet
VPN ¢ Interface
- Hosts
- Host Mame Enable wireless interface: ‘as
Wireless
- Promy
Save Cancel

2. Under the Interface section, click the drop-down menu to enable / disable the wireless network interface.

3. Click Save to apply.
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To configure the roaming trigger threshold for your wireless connection, please do the following:

1. On Atrust Client Setup, click Network > Wireless, and then click Wireless sub-tab.

Atrust

Navigator

- Ethernet
PN

-~ Hosts

-~ Host Name

- Proxy

Atrust Client Setup o alliCS
Applicati User Interf; Devices Network System
Connections Wireless
¢ Interface
Enable wireless interface: [ves -] I; ‘
¢ Roaming
‘ Roaming Signal Strength Trigger: |-70 dBm j = ‘

Save Cancel

2. Under the Roaming section, click the drop-down menu to choose the desired trigger threshold.

5/ NOTE

- To disable wireless roaming, you can choose No roaming here.

3. Click Save to apply.
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4.5.12 Establishing and Stopping a Wireless Connection

NOTE

- Before you can access available wireless networks, you need to install an external
and USB-based wireless network adapter for your t180L. Ensure that you have set up
the required wireless network adapter.

]

+ Your t180L package may not include a wireless network adapter (optional). Please
contact your dealer for compatible adapters if needed. It's recommended to check
with your dealer first if you plan to purchase one by yourself.

Establishing a Wireless Network Connection
To establish a wireless network connection for your t180L/t180LB thin client, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

e N [ R En AT
® Atrust Client Setup | =W | NN [
Atl'l.lSt Applicati User Interf: Devices Network System
Cennections Wireless
- Ethernet
o WPN + Add = Delete O, scan
- Hosts
>----me SsiD signal * Security Status Comment
- Proxy @ @) 100 WPA
Asus 2.4G 100 WPA
HTC Portable Hotspot AAFS 100 WPA
MIX-1 100 WPA
StevenAP 97 WPA
METGEARS3 84 Insecure
Mike - HTC D620 65 WPA
AndroidaP3104 48 WPA
guest0ol a4 WPA
Autosetup 35 WPA
IT-APOZ 356 WPA
TP-LINK_FO35F8 31 WPA
SMCWGBR145-M 20 WPA
testap 20 WPA
IT-APOL 20 WPA

i)

+ Your t180L/t180LB will perform network discovery once and specify all available
wireless networks. To refresh, click Scan on the top of the Wireless Network list.

2. Click to check the desired wireless network. The Connect # Cennect putton then appears on the top of the
Wireless Network list.
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o DEEEE
®) Atrust Client Setup o ol
Atl'l.lSt Applicati User Interf: Devices Network System
Navigator Connections Wireless
- Ethernet
VPN + Add = Delete ©) Scan ¥ Connect
Hosts
_~Host Name SSID Signal * Security Status Comment
IT-APO3 100 WPA
P
rony M1 100 WeA
HTC Portable Hotspot AAFE 96 WRA
IT-APOL 93 WPA
AndroidAP3104 77 WPA
guest00l 74 WPA
Autosetup 71 WPA
¥ IT-APD2 70 WPA
testap 69 WPA
Asus 2,4G 62 WPA
SMCWGBR145-N 58 WPA
Mike - HTC D620 48 WPA
(@_@) 46 WEA
TP-LINK_FO35F8 456 WPA
NETGEARS3 23 Insecure
dir-810-2g 15 WPA
Xperia Z1_bee? 4 WPA

3. Click Connect to create a wireless network connection through the selected wireless network.

4. A window appears prompting for confirmation or authentication.

3‘/ NOTE

L) Wireless Network Authentication Required

Authentication required by wireless network. Passwords or encryption
keys are required to access the wireless network.

Wireless Security: |WPA & WPAZ Personal ;l
ke | ]

Show character

[ Connect H Cancel ]

- If you ever accessed this wireless network before, the password will be automatically
recorded for future access. In this case, you don't need to provide the password
again; you only need to confirm the establishment of a wireless connection.

- Consult your network administrator for required information on authentication.

5. Type in the required password, and then click Connect to continue. Or, click OK to confirm the establishment

of a wireless connection.

6. Upon completion, the Status column of the wireless network will show connected.

SSID Signal * Security Status Comment

(@_@) 100 WPA

IT-APO3 100 WPA

IT-APD2 97 WPA connected  Connected before
Mike - HTC D620 97 WPA

testap 80 WPA

HTC Portable Hotspot AaF8 78 WPA

Xperia Z1_bee7 72 WPRA

AndroidaP3104 71 WPA

TP-LINK_FO35F8 70 WPA
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Stopping a Wireless Network Connection
To stop a wireless network connection, please do the following:
1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network. The Disconnect / Disconnect pytton appears on the top of the
Wireless Network list.

3. Click Disconnect to stop the wireless network connection.

Adding a Wireless Network
In case that you cannot find the desired wireless network in the Wireless Network list, you can manually add it.

To add a wireless network to the Wireless Network list, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.
2. Click Add on the top of the Wireless Network list.

3. On the opened window, type the wireless network name (SSID), select the used wireless security method,
and then provide the required information.

Confirm Dialog

You are going to connect this network.
Are you sure?

Wireless Network Name (SSID); *

Security: |Disab|e Encryption ;l

[ Connect H Cancel l

4. Click Connect to create a wireless connection.

NOTE

- For instructions on how to configure the IP address settings, please refer to section
“4.5.3 Configuring Wired Network Settings” on page 92.

i |

« The default is to use a dynamic IP address assigned by the DHCP server.

5. Upon completion, the added wireless network will be shown on the Wireless Network list and connected will
be shown on its Status column.

Deleting a Wireless Network
To delete a wireless network, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network, and then click Delete to remove the selected wireless network.

NOTE

+ Your t180L/t180LB detects available wireless networks automatically and put the
discovered networks on the Wireless Network list. A deleted wireless network may
therefore appear again on the list, but the connection settings, including the stored
authentication data, will be removed.

i |
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4.5.13 Configuring Wireless Connection Settings

Adjusting Connection settings for a Wireless Network
To adjust connection settings for a wireless network, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network which is currently connected. The Edit =~ .« Edit  button
appears on the top of the Wireless Network list.

3. Click Edit to adjust the settings:

- P
® Atrust Client Setup 1| =R | FEN (P
Atrust Applications  User Interface Devices Network System
- Ethernet
VPN ¢ Wireless Settings 5
- Hosts Wireless Network Name (SSID): * [maroz | &
- Host Name
Mode: [Managed =
- Proxy .
Connect automatically: |Enab\ed ﬂ ]
¢ Authentication
Security: [WPA & WPAZ Personal -] B
Network Key: * |n<»<>«)«)«»cmc | [
Save ] ‘ Cancel

+ On the General tab, click the drop-down menu to configure the automatic connection when this wireless
network is in range and other connection settings.

—=)) NOTE
=g
- By default, your client will connect to a wireless network automatically if it ever
connected to that network successfully.

« On the IPV4 Settings tab, click the drop-down menu or type values in fields to configure IP settings.

S NOTE
« For instructions on how to configure connection settings on the General tab, please
see section “4.5.12 Establishing and Stopping a Wireless Connection” on page 108.
For instructions on how to configure IP address settings on the IPV4 Settings tab,
please see section “4.5.3 Configuring Wired Network Settings” on page 92.

4. Click Save to apply.



112 | Configuring Client Settings
Configuring Network Settings

4.5.14 Configuring Proxy Settings for Web-based Access to Services

To configure proxy settings for Web-based access to services, please do the following:

NOTE

- Settings available here are only applicable to services that use Web-based access,
such as (Microsoft) Remote Web Access and (Citrix) Web Logon connection types.

=

1. On Atrust Client Setup, click Network > Proxy.

2. Click the Mode drop-down menu to select the desired configuration mode. Four modes are available:
No Proxy, Auto-detect proxy settings, Manual proxy configuration, and Auto proxy configuration.

=) NOTE

« The setting items will vary with the selected mode.

Gl

. LR
®) Atrust Client Setup o ol
Atrust Applications User Interface Devices Network System
- Ethernet
" Hosts Connection Settings
~ Host Name Mode: [Mo Proxy -l &
- Wireless

Prox

* These settings are only applicable to senvices that use Web-based access, such as
(Microsoft) Remote Web Access and (Citrix) Web Logon connection types.

Save Cancel
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3. Provide the data as required. Please refer to the following table for a description of each setting item.

Connection Settings

Item Description

Click to select the desired proxy configuration mode.

Mode Description

No Proxy Don’t use any proxy server.

Auto-detect proxy Detects the proxy settings for your network
Mode settings automatically.

Manual proxy

configuration Configures the proxy settings manually.

Auto proxy Loads proxy settings automatically through the
configuration connection to a proxy configuration file.

Mode: Manual proxy configuration

HTTP Proxy Provides the IP address of your HTTP proxy server.

Port Provides the port number which your HTTP proxy server uses.

Provides No Proxy list.

No Proxy for Don’t use any proxy server while connecting to the specified URLs.

Mode: Auto proxy configuration

Provides the URL of a proxy configuration file where proxy settings can be loaded

URL through the network.
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4.6 Configuring Service Access Settings

4.6.1 Applications Tab Overview

Applications tab enables you to configure settings for service access on clients. To access available settings of
Applications tab, click the tab on Atrust Client Setup.

Applications Tab Overview

® N PN R Y

Atrust Client Setup A | RN FE R

Atl'l.lSt Applications User Interface Devices Network System

Remote Desktop )
Citrix ICA el Remote Desktop 2vailable Sessions: 0 X0

WMware View & Configure RDP (Remote Desktop Protocol) connection settings
S5H

Citrix ICA Available Sessions: 0
Configure Citrix ICA connection settings

g VMware View Available Sessions: 0
— Configure VMware Wiew connection settings

8SH Available Sessions: 0
&F Configure SSH (Secure Shell) session settings

Interface Elements

No. Name Description

I Click to select a setting item under Applications tab or to select a setting
1 Navigation area A
entry under a selected setting item.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4.6.2 Available Settings at a Glance

Tab Setting Icon Description Section Page

Click to configure RDP (Remote Desktop Protocol)

Remote Deskto - connection settings and create shortcuts on 222 Eg
P s the local desktop and START menu for Remote o
— ) 4.6.5 131
Desktop sessions.
4.6.6 146
Click to configure ICA (Independent Computing 4.6.7 159
Citrix ICA Architecture) connection settings and create 4.6.8 160
shortcuts on the local desktop and START menu 4.6.9 161
Applications for ICA sessions. 4.6.10 162
4.6.11 169
Click to configure VMware View connection 4.6.12 198
VMware View [ " | settings and create shortcuts on the local desktop  4.6.13 200
— and START menu for View sessions. 4.6.14 202
Click to configure SSH (Secure SHell) connection 4.6.15 207
SSH ol settings and create shortcuts on the local desktop 4.6.16 509

and START menu for SSH sessions.
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4.6.3 Configuring Basic RDP Connection Settings

The Remote Desktop setting allows you to configure RDP (Remote Desktop Protocol) connection settings and
create shortcuts on the local desktop and START menu for service access. You can access remote desktops or
applications for work simply through these shortcuts.

NOTE

(W)

« For more information on Mirosoft Remote Desktop services, please visit Microsoft
website at www.microsoft.com.

Three connection types are available:

Connection Type Description Page
Remote Desktop Select to access remote desktop/application services. 117
Remote Web Access Select to access remote application services through a Web browser. 119

Web Feed Select to access remote application services through published desktop shortcuts. 121
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Connection Type: Remote Desktop

To quickly configure RDP connection settings for the Remote Desktop connection type, please do the following:

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

» Eo A
® Atrust Client Setup Lalloullolles

Atrust Applications User Interface Devices Network System

I + Add l[ - Delere
e maEl IEELER Session Name ~ Server Address

Citrin ICA
- WMware View
L.55H

Connection Type

5/ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.

® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
Navigator General Options RD Gateway
Remote Desktop

- Citrix ICA ¢ Server Settings §

s WMware View Session Mame: * ‘ | [
Computer: & *

P X, 1%
Connection Type: \ Remote Desktop hd h
Network Level -
Authentication: [Enabled 1=
Server Authentication: ‘ Connect and don't warn me LI h
¢ Login Settings y
Username: | | =
Password: [ | |_
Domair: | | h
.'_ Use Smart Card Login
« Common Settings

Autostart When Startup: [Mo e
0on Application Exit: |Do MNothing e
Save l | Cancel

4. On General sub-tab, type in the session name and the server/virtual machine address under the Server
Settings section.
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NOTE

« The red asterisks indicate the required fields.

i

+ The remote service-hosted computer can be a physical server or a virtual machine.
Please visit Microsoft’s websites at www.microsoft.com or support.microsoft.com for
more information.

+ t180L/t180LB supports up to two Remote Desktop sessions at the same time.

« Windows® RemoteFX™ is the technology that offers a rich user experience over a
network for remote desktop users.

NOTE

(alll |

- To create an entry of RDP connection settings for MultiPoint™ Remote Desktop
sessions, please do the following:

, ion. click &) iscoveri iPoint™
1. Inthe Server Settings section, click °, =< to start discovering MultiPoint
Server systems over your network.

2. Inthe opened window, click the drop-down menu to select the desired
server, and then click OK to confirm.

3. The name and IP address of the selected server will be filled out in the
corresponding fields automatically.

« The default session name will be the name of the selected MultiPoint host server,
but you still can change the default.

+ Windows® MultiPoint™ Server is a shared resource technology. This Windows-based
operating system enables a host server to power multiple and independent stations,
allowing users to share the computing power of one single server. Based on this
operating system, Atrust offers a complete solution including both servers and
clients. For more information, please visit our website at www.atrustcorp.com.

5. Click Save to add this RDP connection entry.

6. The shortcuts for Remote Desktop services are automatically created on the local desktop and START menu.

NOTE

Wl

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.6.5 Configuring Advanced RDP Connection Settings” on page 131.
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Connection Type: Remote Web Access

To quickly configure RDP connection settings for the Remote Web Access connection type, please do the following:

5/ NOTE

+ Atrust t180L/t180LB supports only RD Web Access based on Windows Sever 2012
R2; Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

S T T T A TG R
® Atrust Client Setup Lalloullolles
Atrust Applications User Interface Devices Network System
I + Add l [ - Delere
Remote Desktop v
~Citrix ICA Session Name Server Address Connection Type

- WMware View

%J‘ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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® Atrust Client Setup lla )l Cl
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
trix 1CA - Server Settings
VMware View Session Name: * &
Computer: *
P wag | =
Connection Type: \ Remote Desktop ;I h..
Network Level = =
Authentication: [Enabled R S

Server Authentication:

[Connect and don't warn me_~| l-..

- Login Settings

Username:
Password:
Domain:

._'_ Use Smart Card Login

® Atrust Client Setup o LC
Atrust Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
- Citris ICA Server Settings
WMware View
-55H -
Session Name: * | | =
Connection URL: * | | ‘_
Connection Type: | Remote Web Access - .__
Common Settings
Autostart When Startup: |No j h..
on Application Exit: |D0 Nothing j .-
I Save ] [ Cancel ]

5. Type in the session name and connection URL through which Web-based remote applications is accessible.

5/ NOTE

« The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate connection URL.

6. Click Save to add this RDP connection entry.

7. The shortcuts for Remote Web Access are automatically created on the local desktop and START menu.
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Connection Type: Web Feed
To quickly configure RDP connection settings for the Web Feed connection type, please do the following:

5/ NOTE

+ Atrust t180L/t180LB supports only RD Web Feed based on Windows Sever 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

S T T T A TG R
® Atrust Client Setup Lalloullolles
Atrust Applications User Interface Devices Network System
I + Add l [ - Delere
Remote Desktop v
~Citrix ICA Session Name Server Address Connection Type

- WMware View

%J‘ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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® Atrust Client Setup N =N | W= | B
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
trix 1CA - Server Settings
VMware View Session Name: [ 1™
Computer: *
P wag | =
Connection Type: \ Remote Desktop ;I h..
Network Level = =
Authentication: [Enabled R S
Server Authentication: [Connect and don't warn me_~| l-..
- Login Settings )
Username: | | .__
Password: | | h.
Domain: | | =
._'_ Use Smart Card Login
- Common Settings
Autostart When Startup: |No i h..
On Application Exit: |Do Nothing i h..
Save l | Cancel
4. On General sub-tab, click the Connection Type drop-down menu to select Web Feed.
- Lodl _Jdledled
® Atrust Client Setup N =N | W= B
Atrust Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
trix ICA Server Settings
o WMware View :
L. 55H Session Name: * | | e
Web Feed URL: | | &
Connection Type: |Web Feed i .-
Login Settings
Username: * | | h.
Password: * | | h..
Domain: * | | h..
RemoteApp and Desktop Connections
Update Now
summary:
Last Update:
I Save ] [ Cancel ]

5. Type in the session name, Web Feed URL through which remote applications is accessible, and your
credentials for Web Feed.

%J’ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate Web Feed URL.
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6. Click Update Now in the RemoteApp and Desktop Connections section. After completion, the result will be
shown as below in that section.

RemotefApp and Desktop Connections

Summary: 3 applications, 0 desktops
Last Update: Marn Jun 30 2014 10:13:16

%J’ NOTE

+ You can and need to use Update Now to refresh the Web Feed summary if there are
newly published applications. Otherwise, new applications will not be accessible.

7. Click Save to add this RDP connection entry.

8. Afolder named Work Resources with access shortcuts will be automatically created on the local desktop.

B2l | @ (Terminal]
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9. Access shortcuts for available applications can be found in that folder.

Work Resources - File Manager ool
File Edit View Go Help
& B 6 @|fhome!user!DesIaop!Work Resources/ §|
DEVICES
g B
@ File System
Calculator Paint WordPad

PLACES

@ user

:“-' Desktop

Trash

3 items (745 bytes), Free space: 390.2 MB

%J‘ NOTE

+ You need to use Update Now described in Step 6 to refresh the Web Feed if there
are newly published applications. Otherwise, new applications will not be shown.
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4.6.4 Accessing Remote Desktop Services

Connection Type: Remote Desktop
To access remote desktops, please do the following:

1. Double click the created shortcut on the desktop.
2. Follow the on-screen instructions and provide required credentials if needed.

3. The remote desktop will be displayed on the screen.

Example: Windows MultiPoint Server 2012

°
WMSUT &

Example: Windows Server 2012

B8 Windows Server 2012R2
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Example: Windows 8 Enterprise

= NOTE
)
+ The connection type of Remote Desktop also allow you to launch application-
only sessions; only a specific application is launched rather than a full desktop.

For details, please refer to section “4.6.5 Configuring Advanced RDP Connection
Settings”on page 131.



Connection Type: Remote Web Access
To access remote applications, please do the following:

1. Double click the created shortcut on the desktop.

2. A window appears prompting for credentials.

Work Resources

(2¢) RemoteApp and Desktop Connection

Configuring Client Settings

Configuring Service Access Settings

his web page, you
complies with your

‘@/ NOTE

« A warning message “This Connection is Untrusted” might appear. Consult the
IT administrator for details and ensure the connection is secure first. To import
a security certificate, please refer to section “4.2.14 Importing Certificates for
Remote Computers” on page 64.To bypass, click | Understand the Risks > Add

Exception > Confirm Security Exception.

& ¥ TIP

- To exit this Logon screen or other screens and return to the local desktop, please

press Alt + F4.

3. Provide your credentials, and then click Sign in.
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4. Access shortcuts will be shown on the screen.

Work Resources -

RemoteApp and Desktop Connection

RemoteApp and Desktops

Help  Sign out

Current folder: /

Wordpa

Calculator

5. Click or Double-click to select the desired application.

6. A window appears prompting for credentials.

- Windows Security i
Enter your credentials

These credentials will be used to connect to
VRDWEB12RZ2.RDWEB.FOC: 3389,

7. Provide your credentials, and then click OK to launch the selected application.

Q/ TIP

+ Use Alt + Tab to select and restore a hidden or minimized application or desktop.
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Connection Type: Web Feed

1. Double click Work Resources folder on the local desktop.

Atrust

| @ trerminai)

2. Access shortcuts for available applications can be found in that folder.

Work Resources - File Manager

File Edit View Go Help
@ B & @|fhome!user!DesIaop!Work Resources/

DEVICES )
g B
@ File System
Calculator Paint WaordPad

PLACES

@ user

G “ Desltop

Trash

3 items (745 bytes), Free space: 390.2 MB

3. Double-click to select the desired application.
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4. A window appears prompting for credentials.

o " EEd
- Windows Security vl
Enter your credentials

These credentials will be used te connect to
VRDWEB1 2R2.RDWERB.POC: 3389,

Username: o D
Password: :]
Domain: :]

5. Provide your credentials, and then click OK to launch the selected application.

Remote Application Examples
Mozilla Firefox and Calculator

@ MoilaFirefox tart Page

Fle Edt View Go Help
€ & & O[5 /momefuser/Desktop/Work Resources/
DEVICES

_— e 9
~ 5 “ File System -
Google Caledlator  Mozilla Firefox Paint
PLACES
() GrmRs s Do =

() Desktop WordPad

¥ * O % O @ rreminn &

Downloads  Bookmarks  History Add-ons Sync

Choose What I Share | %

Calculator
View Edit Help

"Calculator” (251 bytes) desktop configuration file

Bl | caicutator @ Mozila Firefox Start

. | & [Terminal] [ Work Resources - File..
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4.6.5 Configuring Advanced RDP Connection Settings

The tables below provide a description of each setting item for RDP connections. Please refer to these tables to
configure advanced settings and customize shortcuts on local desktop and START menu for service access.

NOTE

(]

« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Remote Desktop

= NOTE
— - For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 139.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 142.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Desktop sessions.
C Type in the computer name or IP address of the server where to deliver a
omputer .
Remote Desktop session.
This table only provides descriptions for available settings when Remote
Desktop is selected.
Three connection types are available:
Option Description
Connection Type Remote Desktop Select to access remote desktop/application services.
Remote Web Access Select to access remote application services through

a Web browser (Mozilla Firefox).

Select to access remote application services through
Web Feed published desktop shortcuts.

Select to enable/disable Network Level Authentication.

NOTE: Network Level Authentication is the authentication method used to

I enhance the server security by requiring that the user be authenticated
Network Level Authentication before the logon screen is displayed and a session is created. This is a
more secure authentication method that can help protect the remote
computer from malicious users and software.
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Server Authentication

Select what to do next if the client cannot verify the identity of the remote
computer. Three options are available: Connect and don’t warn me,
Warn me, and Do not connect.

Option Description

Connect and don't Connects anyway without any warning.

warn me
Warns and allows users to choose whether t
Warn me a and allo o choo (o]
connect or not.
Do not connect Disallows the connection.

NOTE: To import certificates for remote computers, please refer to section
“4.2.14 Importing Certificates for Remote Computers” on page 64.

Login Settings

Item Description
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Type in the domain of the server.
Domain NOTE: Domain is a collection of computers on a network that share a common

database and security policy. Leave this field blank if the server doesn’t

belong to any domain.

Use Smart Card Login

Check to enable logon with a smart card.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description
The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.
Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

2 Autostart

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:

e Returning to the local desktop
e Re-launching a new session

e Restarting the thin client

e Turning off the thin client

3 Quick Connection

The default. The client will enter Atrust Quick
Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a Remote Desktop session is ended. Five options are
available: Do Nothing, Restart Application, Force-Restart Application,

Reboot, and Shutdown.

Option

Description

Do Nothing

Returns to the t180L/t180LB local Linux desktop.

Restart Application

Opens a Remote Desktop session again.

Force-Restart Application

Opens a Remote Desktop session again and
skips any messages in-between.

Reboot

Restarts your t180L/t180LB.

Shutdown

Turns off your t180L/t180LB.
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Options Sub-tab

Programs

Item

Description

Start the following program on
connection

Click the drop-down menu to enable or disable the Application mode. Use this
option to select the session type. Two remote session types are available:

e Remote Desktop (when the Application mode is disabled)
e Remote Application (when the Application mode is enabled)

NOTE: Remote Application sessions are Remote sessions used to access only
specific applications rather than full desktops.

NOTE: Before you can open a Remote Application session, you need to add the
desired application to the RemoteApp Programs list with RemoteApp
Manager on the host server. For detailed instructions on how to add a
desired application to the RemoteApp Programs list on the server, please
visit Microsoft’s website at www.microsoft.com.

Start in the following folder

Type in the location of the desired application (on the host server) if Start the
following program on connection is enabled.

NOTE: You can type in the location/path of the desired application in this field,
and specify only the name of the application in Program path and file
name (the next field). Or, you can type in the full path and name of the
application in Program path and file name, and leave this field empty.

Program path and file name

Type in the name of the desired application if Start the following program on
connection is enabled.

Remote APP Format Example

Windows Media Player C:\Programs Files (x86)\Windows Media Player\wmplayer.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32

NOTE: the file extension can be omitted.

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Five options are available: Automatic, 15 Bit, 16 Bit, 24 Bit,
and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: The Automatic option uses the setting defined by the host server.
NOTE: You can configure the upper limit of the color depth for a Remote Desktop

session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.
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Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Four options are available: Fullscreen, Large Window,
Medium Window, and Small Window.

Option Description

Opens a Remote Desktop session in full screen with the same

Fullscreen display resolution as the local desktop.

Large Window Opens a Remote Desktop session in a large display resolution.

Medium Window Opens a Remote Desktop session in a medium display resolution.

Small Window Opens a Remote Desktop session in a small display resolution.

NOTE: To configure the display resolution of the local desktop, please refer to
section “4.3.3 Configuring Display Settings” on page 70.

Use Toolbar

Click the drop-down menu to select whether to use the Atrust Toolbar on a
Remote Desktop session. The tool bar allows you to adjust a session window size
or suspend a session.

Atrust & %

Cursor Auto-hide

Click the drop-down menu to enable/disable the auto-hiding of the mouse cursor
or pointer on inactivity in Remote Desktop sessions.

Use RemoteFX

Click the drop-down menu to disable/enable RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: To enable the RemoteFX feature for Remote Desktop sessions on your
t180L/t180LB thin client, you still need to configure the host server. For
detailed instructions on how to enable RemoteFX on a host server, please
visit Microsoft Support website at support.microsoft.com.

Progressive Rendering

Click the drop-down menu to disable/enable progressive rendering.

When enabled, images and videos will be encoded and sent over progressively
when the network bandwidth is limited. This new RemoteFX feature is supported
by Windows Sever 2012 and Windows 8.

NOTE: This option is shown only when Use RemoteFX is enabled.

Use Bulk Compression

Click to enable/disable the bulk compression for the data traffic between the
server and client.
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Optimization Settings

Item

Description

Connection Quality

Select the option that best describes the quality of your network connection.
Three options are available: LAN (Very Fast), Broadband (Fast), and
Modem (Slow).

NOTE: Selection here will determine the defaults of items in this section as
listed below.

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Visual styles

Check to allow non-classic themes.

Persistent bitmap caching

Check to allow client-side cache of bitmaps for a session.

Connection Settings

Item

Description

Multimedia Redirection

Click the drop-down menu to disable/enable multimedia redirection.

When enabled, the client receives original compressed multimedia streams and
decodes locally for display. This feature increases the load on the client, but
saves server resources, decreases the bandwidth usage, and improves audio and
video playback experiences.

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in a Remote Desktop session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in a Remote Desktop session.
The default is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
“4.4.3 Configuring Settings for USB Storage Devices” on page 82.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add a local or network printer for your t180L/t180LB first,
and then enable this feature here to use that printer in a Remote
Desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
t180L/t180LB, please refer to section “4.4.7 Adding a Local Printer” on
page 86 or "4.4.8 Adding a Network Printer” on page 89.
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Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in a Remote Desktop session.

Parallel Port Mapping

Click the drop-down menu to enable/disable parallel port mapping.

When Enable is selected, users can access a parallel device, such as a printer or
scanner, in a Remote Desktop session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in a Remote Desktop session.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in a Remote Desktop

Play on this computer session using locally attached audio devices.

Allows audio playback in a Remote Desktop
Play on remote computer  session using audio devices attached to the
remote computer.

Disables audio playback in a Remote Desktop

Do not play session using locally attached audio devices.

Remote Audio Recording

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description
Recording from this Allows audio recording in a Remote Desktop
computer session using locally attached audio devices.

Disables audio recording in a Remote Desktop

Do not record session using locally attached audio devices.
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RemoteFX USB Redirection Settings

Item

Description

Use RemoteFX USB Redirection

Check/Uncheck to enable/disable locally attached USB devices in a Remote
Desktop session (virtual machine based only).

NOTE: RemoteFX USB Redirection allows the redirection of USB devices into
server-hosted virtual machines (with guest operating systems).

NOTE: RemoteFX USB Redirection is only applicable to the virtual machine based
Remote Desktop service not to session based one. For more information,
please visit Microsoft Support website at support.microsoft.com.

On the client side, please do the following to enable locally attached USB devices
in a virtual machine based desktop:

1. Ensure that the desired USB device has been connected to your client.

Ensure that RemoteFX is enabled on your t180L/t180LB (see “Use
RemoteFX” on page 135).
3. Click to check Use RemoteFX USB Redirection.

4. A new checkbox appears with the required device driver. Check to enable
the driver.

5. Click Save to apply.

NOTE: You also need to configure the host server and its guest OSs to enable
RemoteFX USB Redirection in a Remote Desktop session. For instructions

on server-side configuration, please visit Microsoft Support website at
support.microsoft.com.

RD Gateway Sub-tab

Connection Settings

Item

Description

Use RD Gateway server

Check/Uncheck to enable/disable the use of an RD Gateway server. When
checked, the following two items in this table appear.

Server Name

Type the name of the RD Gateway server. Ask the network administrator for
this information.

Use my Remote Desktop
credentials for the RD Gateway

Check to use the same set of credentials for authenticating to both the Remote
Desktop computer and the RD Gateway server.

Bypass RD Gateway for
local address

Check to prevent traffic to and from local network addresses from being routed
through the RD Gateway server. This could make your RDP connection faster.
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Settings for the Connection Type of Remote Web Access

=) NOTE

- For descriptions of settings for the connection type of Remote Desktop, please refer
to “Settings for the Connection Type of Remote Desktop” on page 131.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 142.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Web Access sessions.
Connection URL Type in the URL of the server where to deliver Remote Web Access sessions.

This table only provides descriptions for available settings when Remote
Web Access is selected.

Three connection types are available:

Option Description

Connection Type Remote Desktop Select to access remote desktop/application services.

Select to access remote application services through

Remote Web Access a Web browser (Mozilla Firefox).

Select to access remote application services through
Web Feed published desktop shortcuts.
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Common Settings

Item Description

Select whether to open a Remote Web Access session automatically or not when
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Select what to do when a Remote Web Access session is ended. Five options
are available: Do Nothing, Restart Application, Force-Restart Application,
Reboot, and Shutdown.

Option Description
Do Nothing Returns to the t180L/t180LB local Linux desktop.
On Application Exit Restart Application Opens a Remote Web Access session again.

Opens a Remote Web Access session again and

Force-Restart Application skips any messages in-between.

Reboot Restarts your t180L/t180LB.

Shutdown Turns off your t180L/t180LB.
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Options Sub-tab

% ) NOTE
— - No options are available under the Options sub-tab in the connection type of
Remote Web Access.
RD Gateway Sub-tab
=) NOTE
7

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.
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Settings for the Connection Type of Web Feed

=

General Sub-tab

NOTE

For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 131.

For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 139.

Server Settings

Item

Description

Session Name

Type in the name for Web Feed sessions.

Web Feed URL

Type in the URL of the server where to deliver Web Feed sessions.

Connection Type

This table only provides descriptions for available settings when Web Feed
is selected.

Three connection types are available:

Option Description

Remote Desktop Select to access remote desktop/application services.

Select to access remote application services through

Remote Web Access a Web browser (Mozilla Firefox).

Select to access remote application services through

Web Feed published desktop shortcuts.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

RemoteApp and Desktop Connections

Item

Description

Update Now

Click to fetch and update the published applications list from the server.
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Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Five options are available: Automatic, 15 Bit, 16 Bit, 24 Bit,
and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: The Automatic option uses the setting defined by the host server.
NOTE: You can configure the upper limit of the color depth for a Remote Desktop

session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Cursor Auto-hide

Click the drop-down menu to enable/disable the auto-hiding of the mouse cursor
or pointer on inactivity in Remote Desktop sessions.

Use RemoteFX

Click the drop-down menu to disable/enable RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: To enable the RemoteFX feature for Remote Desktop sessions on your
t180L/t180LB thin client, you still need to configure the host server. For
detailed instructions on how to enable RemoteFX on a host server, please
visit Microsoft Support website at support.microsoft.com.

Use Bulk Compression

Click to enable/disable the bulk compression for the data traffic between the
server and client.

Optimization Settings

Item

Description

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Visual styles

Check to allow non-classic themes.

Persistent bitmap caching

Check to allow client-side cache of bitmaps for a session.
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Connection Settings

Item

Description

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in a Remote Desktop session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in a Remote Desktop session.
The default is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
“4.4.3 Configuring Settings for USB Storage Devices” on page 82.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add a local or network printer for your t180L/t180LB first,
and then enable this feature here to use that printer in a Remote
Desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
t180L/t180LB, please refer to section “4.4.7 Adding a Local Printer” on
page 86 or “4.4.8 Adding a Network Printer” on page 89.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in a Remote Desktop session.

Parallel Port Mapping

Click the drop-down menu to enable/disable parallel port mapping.

When Enable is selected, users can access a parallel device, such as a printer or
scanner, in a Remote Desktop session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in a Remote Desktop session.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in a Remote Desktop

Play on this computer session using locally attached audio devices.

Allows audio playback in a Remote Desktop
Play on remote computer  session using audio devices attached to the
remote computer.

Disables audio playback in a Remote Desktop

Do not play session using locally attached audio devices.
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Remote Audio Recording

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description

Recording from this Allows audio recording in a Remote Desktop
computer session using locally attached audio devices.
Do not record Disables audio recording in a Remote Desktop

session using locally attached audio devices.

RemoteFX USB Redirection Settings

Item

Description

Use RemoteFX USB Redirection

Check/Uncheck to enable/disable locally attached USB devices in a Remote
Desktop session (virtual machine based only).

NOTE: RemoteFX USB Redirection allows the redirection of USB devices into
server-hosted virtual machines (with guest operating systems).

NOTE: RemoteFX USB Redirection is only applicable to the virtual machine based
Remote Desktop service not to session based one. For more information,
please visit Microsoft Support website at support.microsoft.com.

On the client side, please do the following to enable locally attached USB devices
in a virtual machine based desktop:

1. Ensure that the desired USB device has been connected to your t180L/
t180LB.

2. Ensure that RemoteFX is enabled on your t180L/t180LB (see “Use
RemoteFX” on page 135).

3. Click to check Use RemoteFX USB Redirection.

4. A new checkbox appears with the required device driver. Check to enable
the driver.

5. Click Save to apply.

NOTE: You also need to configure the host server and its guest OSs to enable

RemoteFX USB Redirection in a Remote Desktop session. For instructions

on server-side configuration, please visit Microsoft Support website at
support.microsoft.com.

RD Gateway Sub-tab

NOTE

i |

+ No options are available under the Options sub-tab in the connection type of
Web Logon.
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4.6.6 Configuring Basic ICA Connection Settings

The Citrix ICA setting allows you to configure ICA connections for Citrix services and create shortcuts on the local
desktop and START menu for service access. You can access virtual desktops and applications for work simply

through these shortcuts.

NOTE

@I

« For more information on Citrix desktop virtualization solutions, please visit Citrix
website at www.citrix.com or Citrix Knowledge Center at support.citrix.com.

Six connection types are available:

Connection Type Description
Web Logon Select to access desktop/application services through a Web browser.
StoreFront Select to access desktop/application services through a StoreFront.
VDI-in-a-Box Select to access desktop services through VDI-in-a-Box.
XenDesktop Select to access desktop services through an earlier version of XenDesktop.
XenApp Select to access application services through an earlier version of XenApp.
Server Connection Select to access service delivery servers (XenApp servers only).
= NOTE
7

+ You can refer to the following table for Citrix products and recommended
connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon

Page
147
149
151
153
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Connection Type: Web Logon
To quickly configure ICA connection settings for the Web Logon connection type, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

" Ll dlaled
® Atrust Client Setup Lalboullollles

Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
_ Citrix ICA + Add = Delete
s WMware View

Session Name ¥ Server Address Connection Type

%J‘ NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, leave the connection type as Web Logon as default, and then type in the desired
session name and the IP address / URL / FQDN of the server through which Citrix services are accessible.

- Lol _Jimdlead
® Atrust Client Setup Lalloullallies
Atrust Applications User Interface Devices Network System
General Options
Remote Desktop
Citrix ICA Server Settings
WMware View
55H
Session Mame: il | &
Connection Type: |Web Logon j s
Server Address: * | | e
Common Settings
Autostart When Startup: |N0 e
on Application Exit: |DU Nothing e
Save l [ Cancel

NOTE

« For newer versions of XenDesktop and XenApp, you may need to further specify
the sub-path of the server. Refer to the following table for details:

i)

Component to

Citrix Product Connect

Connection Address

XenApp 6.5 or

earlier Web Interface IP / URL / FQDN

XenDesktop 5.6

or earlier Web Interface  IP / URL / FQDN

IP / URL / FQDN plus sub-path

For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenApp and
XenDesktop 7.5

- FQDN is the acronym of Fully Qualified Domain Name.

5. Click Save to add this ICA connection entry. The access shortcuts are automatically created on the local
desktop and START menu.

NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 169.

% :
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Connection Type: StoreFront
To quickly configure ICA connection settings for the connection type of StoreFront, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, Click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
U + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select StoreFront.

e e [ e
® Atrust Client Setup Lalloullallies

Atl'l.ISt Applications User Interface Devices Network System
Navigator General Options
- Remote Desktep
Citrix ICA ¢ Server Settings \
- VMware View Session Name: = | &
. 5SH
Connection Type: [StoreFront hd 'S
Server Address: “ | e
Username: | | =
Password: [ | e
Domain: [ | e
Desktop Group / Application: "\% * | | ]
¢ Common Settings
Autostart When Startup: | No e
0On Application Exit: | Do Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual applications/
desktops are accessible, and the name of desktop group or application.

=) NOTE
=
+ You can use the Search icon Qg to help you discover available desktop groups or
applications for a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 169.
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Connection Type: VDI-in-a-Box
To quickly configure ICA connection settings for the connection type of VDI-in-a-Box, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, Click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
U + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

151



152 | Configuring Client Settings

Configuring Service Access Settings

4. On General sub-tab, click the Connection Type drop-down menu to select VDI-in-a-Box.

e e [ e
® Atrust Client Setup Lalloullallies

Atl'l.ISt Applications User Interface Devices Network System
Navigator General Options
- Remote Desktop
Citrix ICA ¢ Server Settings
- VMware View Session Name: = | &
. 5SH :
Connection Type: | VDHin-a-Box e
Server Address: “ | I-.
Username: | | I-.
Password: [ | e
Domain: [ | I-.
= .
Desktop Group: '\C_j\'g’ * | | ]
¢ Common Settings
Autostart When Startup: | No i I-.
0On Application Exit: | Do Nothing h I-.
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual desktops are
accessible, and the name of the desktop group.

=) NOTE
i
+ You can use the Search icon QQ’ to help you discover available desktop groups for
a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 169.
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Connection Type: XenDesktop
To quickly configure ICA connection settings for the connection type of XenDesktop, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
U + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select XenDesktop.

- Lol _Jimdlead
® Atrust Client Setup Lalloullallies
Atrust Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix ICA Server Settings
~VMware View Session Mame: [ | ]
- 55H
Connection Type: |XenDesk'top hd 'S
Server Address: * | | e
Username: | | =
Password: | | e
Domain: | | s
Desktop Group: "\% * | | =]
Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Save l [ Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual desktops are
accessible, and the desired desktop group.

NOTE

&

+ You can use the Search icon Qg to help you discover available desktop groups for
a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 169.
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Connection Type: XenApp
To quickly configure ICA connection settings for the connection type of XenApp, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
U + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select XenApp.

- Lol _Jimdlead
® Atrust Client Setup Lalloullallies
Atrust Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix ICA Server Settings
- WMware View Session Name: * | | ]
- 55H
Connection Type: |XenApp hd 'S
Server Address: * | | e
Username: | | =
Password: | | e
Domain: | | s
Application Name: "\% * | | =]
Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Manual Parameters: [ | e
Save l [ Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual applications are
accessible, and the desired application name.

=) NOTE
=
+ You may need to provide the XML port number as well for your server address
(for example, XA65P.CTX.poc:8080), depending on your server-side configuration.
=) NOTE
=

+ You can use the Search icon O% to help you discover available applications for a
given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 169.



Configuring Client Settings | 157

Configuring Service Access Settings

Connection Type: Server Connection
To quickly configure ICA connection settings for the connection type of Server Connection, please do the following:

5/ NOTE

- This connection type is used to connect to XenApp server for administration and
supports only XenApp 6.5 and earlier.

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

. A
® Atrust Client Setup Lalboullollles

Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
: Citrix ICA + Add = Delete
s WMware View

Session Name ¥ Server Address Connection Type

%J‘ NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select Server Connection.

- Lol _Jimdlead
® Atrust Client Setup Lalloullallies
Atrust Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix ICA Server Settings
~VMware View Session Mame: [ | ]
- 55H
Connection Type: | Server Connection hd 'S
Server Address: * | | e
Username: | | =
Password: | | e
Domain: | | s
Server Name: "\% * | =]
Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Save l [ Cancel

5. Type the session name, server address, and server name.

=) NOTE
=
+ You may need to provide the XML port number as well for your server address
(for example, 192.168.77.10:8080), depending on your server-side configuration.
=) NOTE
=

+ Only connections to XenApp servers are supported by this connection type.

+ You can use the Search icon O% to help you detect the server name.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

j NOTE
- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 169.
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4.6.7 Switching the Citrix Receiver Version

Two versions of Citrix Receiver are switchable in case that an older version of Citrix Receiver is required for your
Citrix environment.

To change the version of Citrix Receiver, please do the following:

NOTE

]

- This is a global setting; the change will affect all Citrix connections.

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click the drop-down menu to select the desired Citrix Receiver version. Two options are available:
12.xand 13.x.

® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA - Common Settings )
WMware View - . .
. SSH Citrix Receiver Version: |13,>< j [
Use Esc to quit Web Logon: |Yes j =
Keyboard Layout Depends on: |Loca| j =
Keyboard Type: |Default j [

* The change to the used Receiver version will affect all sessions.

* All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

<\/ TIP

« The default Citrix Receiver version is 13.x.

+ You can refer to the following table for Citrix products and recommended Citrix
Receiver version:

Citrix Product Recommended Receiver Version
XenApp earlier than 6.5 12.x
XenDesktop earlier than 5.6 12.x
XenApp / XenDesktop 7.x or later 13.x

3. Click Save to apply.
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4.6.8 Enabling or Disabling Esc to Quit on the Web Logon Screen

You can choose whether to allow the use of Esc key to quit the Web Logon screen:

If Yes is selected, you can use both Esc and Alt + F4 to quit the Web Logon screen.

- If Nois selected, only Alt + F4 works.

To enable or disable Esc to Quit on the Web Logon screen, please do the following:

allt]

NOTE

- This is a global setting; the change will affect all Citrix connections.

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click the drop-down menu to select Yes or No to enable or disable Esc to Quit.

Atrust

WVMware View
S5H

Atrust Client Setup v llo L]
Applications User Interface Derices Nemwork Sysem
Sessions Global
« Common Settings g
Citrix Recelver Version: [13.x -l e
Use Esc to quit Web Logon: |Yes j =
Keyboard Layout Depends on: |L0ca| j =
Keyboard Type: |Default j [
* The change to the used Receiver version will affect all sessions.
* All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

3. Click Save to apply.
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4.6.9 Configuring Keyboard Layout and Type for Citrix ICA Sessions

To set the used keyboard layout and type for all Citrix ICA sessions, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click drop-down menus to select what determines the keyboard layout and the desired keyboard type.

® Atrust Client Setup N =N | W= | B
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA - Common Settings
WMware View - . . ~
S5H Citrix Receiver Version: |13.x j e
Use Esc to quit Web Logon: |\«’es j E
Keyboard Layout Depends on: |Loca| j h.
Keyboard Type: |Default j B
* The change to the used Receiver version will affect all sessions.
* All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

—)) NOTE
=

« These are global settings; the changes will affect all ICA sessions.

3. Click Save to apply.
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4.6.10 Accessing Citrix Services

For Connection Types of StoreFront, VDI-in-a-Box, XenDesktop, XenApp, and Server Connection
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop, and then provide your credentials if needed.

2. The desired desktop or application will be displayed on the screen.

For Connection Type of Web Logon
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

2. The Web browser is launched in full-screen with the Citrix Logon screen.

Citrix Logon Screen Example: XenApp 6.0 Fundamentals

Citrix Logon Screen Example: XenApp 6.5 Platinum

Citrix XenApp

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

CITRIX' [0%]




Configuring Client Settings | 163

Configuring Service Access Settings

Citrix Logon Screen Example: XenDesktop 5.6 Platinum

Citrix XenDesktop

‘Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

CITRIX" [0x]

Citrix Logon Screen Example: VDI-in-a-Box

Citrix Receiver
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Citrix Logon Screen Example: XenApp and XenDesktop 7.5 Platinum

Citrix Receiver

3. Type in the required credentials, and then click Log On.

NOTE

- If your XenApp server doesn’t belong to any domain, type in the server name in the
Domain field instead.

[l
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4. On the Desktop or Application Selection screen, click to select the desired desktop or application(s).

@ NOTE

+ You might enter the virtual desktop directly if only one type of virtual desktop is
assigned to the provided credentials.

Selection Screen Example: XenApp 6.5 Platinum

Search 4 a i -
B Logged on as:CTxAl sefis | logon~  CHRIX

= e
<) @

Notepad PDF Reader X PP Viewer 2007

Hint: ik D 10 pause any runming

Selection Screen Example: XenDesktop 5.6 Platinum

CITRIX'

Settings Log Off

W7Ue WS2KBR2e
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Selection Screen Example: XenApp 7.5 Platinum

Selection Screen Example: XenDesktop 7.5 Platinum
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5. The selected virtual desktop or application(s) will be displayed on the screen.

Virtual Application Examples
PowerPoint Viewer, Adobe Reader, and Notepad

P—— LB cmx

Il

File Edt View Window Help
Dl

RAFBEX |

Tools i Sign i Comment

ADOBE' READER X

Open a Recent File Acrobat.com Services

Open. @ CreatePDF Online
] Convert PDF to Word or Exce Online
% Share Files Using Sendiow Online

@ Get Documents Signed

i [Fowmens 5] @3 2@

Hame -+ || Date modfied || Type 1=
N items fatch your search,

wur PDF File:

Jey Note and Highlighter
ments to your FOF

gl | o

Fi name: 2 Dpen

Files o type: FowerPaint Presertalions ~ E=)
%

Virtual Application Examples
Adobe Reader, Mozilla Firefox, and PowerPoint Viewer

CitrixReceiver

@ MosilaFifocstartPage % |

Vindow_Help

poaments &) ) [ @ [ & [

Search

Open a Recent File Adobe Online Services

@ W Conputer @) Convet#05toVrdor
22 Acosacom

2 Creste OF

Send. kFileOnline.
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Virtual Desktop Example
Windows 7 Ultimate

Welcome to your Citrix XenDesktop

Any Device

Access is easyfrom any PG,
Wac, smartphone or tablet
The choice s yours.

Welcome to the virtual workstyle -
Your desktop, apps and documents at your fingertips :E;::::::):andsmnm

leskiop, and the freedom to do whatever, whenever, graphics over any network,
it including Wi-Fi or 3

W Dont show the welcome screen again.

S ) B35
2O

Virtual Desktop Example
Windows Server 2008 R2

0> L3k

=il
|




Configuring Client Settings | 169

Configuring Service Access Settings

4.6.11 Configuring Advanced ICA Connection Settings

The tables below provide a description of each setting item for ICA connections. Please refer to these tables to
configure advanced settings and customize shortcuts on the local desktop and START menu for service access.

—=)) NOTE
w/f
« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Web Logon

=) NOTE
7
- For descriptions of available settings for the connection type of StoreFront, please
refer to “Settings for the Connection Type of StoreFront” on page 173.

- For descriptions of available settings for the connection type of VDI-in-a-Box, please
refer to “Settings for the Connection Type of VDI-in-a-Box” on page 178.

- For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 183.

« For descriptions of settings for the connection type of XenApp, please
refer to “Settings for the Connection Type of XenApp” on page 188.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 193.
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General Sub-tab

Server Settings

Item Description

Session Name Type in the name of browser sessions for Citrix service access.

This table only provides descriptions for available settings when Web Logon
is selected.

Six connection types are available:

Option Description
Web Logon Provides access to virtual desktops and applications

9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications

through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.
. Provides access to virtual applications for an earlier
Connection Type XenApp version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon

Type in the IP address / URL / FQDN of the server through which Citrix services
are accessible.

Refer to the table below for details:

Component to

Connect Connection Address

Citrix Product

XenApp 6.5 or Web Interface  IP/ URL / FQDN

earlier
Server Address
XenDesktop 5.6 \yop 1nterface 1P/ URL / FQDN
or earlier
IP / URL / FQDN plus sub-path
XenApp and For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenDesktop 7.5
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Common Settings

Item Description

Select whether to open a browser session for Citrix service access automatically
or not when your t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Select what to do when a browser session for Citrix service access is ended.
Four options are available: Do Nothing, Restart Application, Reboot, and

Shutdown.
Option Description
Do Nothing Returns to the Local Linux desktop.

On Application Exit

Restart Application  Opens a browser session again for service access.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s)
and to select access type in a Citrix ICA session. Three options are available: No, Read
Only, and Read Write. If Read Only or Read Write is selected, the locally attached USB
drive(s) will become available in launched Citrix ICA sessions.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 82 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your t180L/t180LB. However, if you
use a serial-based barcode scanner, and attach it to your t180L/t180LB
with a serial-to-USB adapter, you need to enable this setting in order to
use the local barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 86 for detailed instructions.

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Check to enable H.264 compression support on the client, allowing session data
are sent from the server side using H.264 format encoding.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 57 for detailed instructions on these similar settings.
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General Sub-tab

NOTE
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For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 169.

For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 178.

For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 183.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 188.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 193.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

is selected.

This table only provides descriptions for available settings when StoreFront

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
or applications are accessible (where a StoreFront is hosted).

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group / Application

Type in the name of the desktop group / application or use the Search icon Oxg,
in front of the field to discover available desktop groups / applications.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and
800x600.
) Click the drop-down menu to select the desired window mode. Two options are
Window Mode

available: Regular Window and Seamless Window.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 82 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your t180L/t180LB. However, if you
use a serial-based barcode scanner, and attach it to your t180L/t180LB
with a serial-to-USB adapter, you need to enable this setting in order to
use the local barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 86 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Check to enable H.264 compression support on the client, allowing session data
are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 57 for detailed instructions on these similar settings.
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Settings for the Connection Type of VDI-in-a-Box

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 169.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 173.

For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 183.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 188.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 193.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

is selected.

This table only provides descriptions for available settings when VDI-in-a-Box

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
are accessible.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group / Application

Type in the name of the desktop group or use the Search icon O\g in front of the
field to discover available desktop groups.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 82 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your t180L/t180LB. However, if you
use a serial-based barcode scanner, and attach it to your t180L/t180LB
with a serial-to-USB adapter, you need to enable this setting in order to
use the local barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 86 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Check to enable H.264 compression support on the client, allowing session data
are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on

page 57 for detailed instructions

on these similar settings.
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Settings for the Connection Type of XenDesktop

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 169.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 173.

For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 178.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 188.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 193.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

selected.

This table only provides descriptions for available settings when XenDesktop is

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
are accessible (where a Web Interface is hosted).

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group

Type in the name of the desktop group or use the Search icon O\g in front of the
field to discover available desktop groups.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.

Options Sub-tab

Window Settings

Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 82 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your t180L/t180LB. However, if you
use a serial-based barcode scanner, and attach it to your t180L/t180LB
with a serial-to-USB adapter, you need to enable this setting in order to
use the local barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 86 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Check to enable H.264 compression support on the client, allowing session data
are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @a moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.
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Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.

Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to “Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 57 for detailed instructions on these similar settings.
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Settings for the Connection Type of XenApp

=) NOTE

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 169.

- For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 173.

- For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 178.

- For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 183.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 193.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when XenApp
is selected.

Six connection types are available:

Option Description

Provides access to virtual desktops and applications

Web Logon through the interface of a Web browser (Mozilla Firefox).

Provides access to virtual desktops and applications

Storefront through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.
. Provides access to virtual applications for an earlier
Connection Type XenApp version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of a XenApp server.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Application Name

Type in the application name or use the Search icon O\g in front of the field to
discover available applications.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.

Manual Parameters

Type in parameters for extended parameter passing.

Options Sub-tab

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: 16 Bit, 24 Bit, and Automatic.

Window Size

This item is available only when Regular Window is selected.

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Four options are available: Full Screen, 1280x1024, 1024x768, and
800x600.

Window Mode

Click the drop-down menu to select the desired window mode. Two options are
available: Regular Window and Seamless Window.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 82 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your t180L/t180LB. However, if you
use a serial-based barcode scanner, and attach it to your t180L/t180LB
with a serial-to-USB adapter, you need to enable this setting in order to
use the local barcode scanner in a delivered application.
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Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 86 for detailed instructions.

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Check to enable H.264 compression support on the client, allowing session data
are sent from the server side using H.264 format encoding.

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio

Check/Uncheck to enable/disable sound in an ICA session.
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Audio Quality

Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.

Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where

bandwidth is plentiful and sound quality is
important.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Low Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.

Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 57 for detailed instructions on these similar settings.
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Settings for the Connection Type of Server Connection

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 169.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 173.

Fore descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 178.

For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 183.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 188.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

This table only provides descriptions for available settings when
Server Connection is selected.

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Type in the IP address / URL / FQDN of the XenApp server.

Server Address NOTE: Server Connection only supports connections to XenApp servers.

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Server Name Type in the name of the server.

Common Settings

Item Description

Select whether to open a Citrix ICA session automatically or not when your
t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.




Configuring Client Settings
Configuring Service Access Settings

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 82 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your t180L/t180LB. However, if you
use a serial-based barcode scanner, and attach it to your t180L/t180LB
with a serial-to-USB adapter, you need to enable this setting in order to
use the local barcode scanner in a virtual server desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 86 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Check to enable H.264 compression support on the client, allowing session data
are sent from the server side using H.264 format encoding.

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.
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Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.

Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to “Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 57 for detailed instructions on these similar settings.
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4.6.12 Configuring Basic VMware View Connection Settings

The VMware View setting enables you to configure View connection settings for VMware View or Horizon View
services and create shortcuts on the local desktop and START menu for service access. You can access on-demand
services for work simply through these shortcuts.

=) NOTE
=
« For more information on VMware desktop virtualization solutions, please visit
VMware website at www.vmware.com.

To quickly configure VMware View connection settings, please do the following:

1. On Atrust Client Setup, click Applications > VMware View.

2. The View Connection list appears in the Configuration area.

e T o2
® Atrust Client Setup N =N | W= B
Atrust Applications User Interface Devices Network System

+ Add || = Delete

- Remote Desktop
- Citrix ICA
VMware View

Session Name ¥ Connection Server

NOTE

i

- If you haven't created any entry, the View Connection list will be empty.

3. Click Add on the top of the View Connection list to add a new entry of View connection.


http://www.vmware.com

EEEES

Atrust

WVMware View

Atrust Client Setup
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Certificate checking mode:

Applications User Interface Devices Network System
General Options SECUREMATRIX
- Server Settings
Session Name: * || | -]
Connection Server: “ | I-.
Port: [ | &
Use Secure Connection(SSL): |‘r‘es ;l I-.

|Warn before connecting to |;| .-

When Connection Ends: [Return to VMware Pool | ._
- Login Settings
User Name: | | I-.
Password: | | I-.
Domain: | | I-.
Desktop [ Application Name: € | | h
\erify before Access: | No ;l I-.
Preferred Display Protocol: [Manual Rd| e

Common Settings

Save l | Cancel

4. Type in the desired session name and the computer name or IP address of the View Connection Server, and

then click Save to confirm.

=)) NOTE
=

« These are the only required fields for the creation of a service access shortcut on the
desktop. Other data can be provided during the period of service access. Depending

on your needs, you might choose to type in more other data.

5. The new entry is added to the View Connection list and the access shortcuts are automatically created

on the local desktop and START menu.
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4.6.13 Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Double click the created (customized) access shortcut on the desktop.

NOTE

« A window might appear with a certificate message about the remote server.
Consult the IT administrator for details and ensure the connection is secure first.
To import a security certificate, please refer to section “4.2.14 Importing Certificates
for Remote Computers” on page 64. To bypass, click Connect Insecurely.

=

2. AWelcome window might appear. Click OK to continue.

3. A window appears prompting for the credentials. Enter your user name, password, click the Domain drop-
down menu to select the domain, and then click OK.

Server Login

vmware Horizon

Server: (@ hitps!/AMCSVHVpoc

Username: |\ |

Password: | |

Domain: |VHV | kv |

|gance| || Jolis |

4. A window appears with available desktops and/or applications for the provided credentials.

® VMware Horizon Client =

File  Connection View Help

&% [ bttpsMICS VHVpoC

L @

Adobe Reader XI Calculator LINE Mozilla Firefox

4 o Q N

Notepad Paint Skype W7U

5. Double click to select the desired desktop or application.
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6. The selected desktop or application will be displayed on the screen.

NOTE

(]

- Your desktop or application will be displayed in full screen. You can:

< Click File > Return to Desktop and Application List on the top tool bar to
recall the Desktop and Application list.

WMware Horizon Client Connection ¥ View > Help~ | (O [0 X

4r Disconnect from Server...
\ Return to Desktop and Application List |

o Quit

< Click View on the top tool bar to switch to a virtual desktop or application.

WMware Horizon Client File * Connection ¥ Help» | (2 @ X

Windowed

® Full Screen - This Monitor
Full Screen - All Monitors
Resize |

Adobe Reader

@ Firefox

O LNE

|-l Windows Calculator
= w7u
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4.6.14 Configuring Advanced View Connection Settings

The table below provides a description of each setting item for View connections. Please refer to this table to
configure advanced settings and customize shortcuts on the local desktop and START menu for service access.

General Sub-tab

Server Settings

Item

Description

Session Name

Type in the name for VMware View or Horizon View sessions.

Connection Server

Type in the computer name or IP address of the View Connection Server.

NOTE: For more information on View Connection Server, please visit VMware
website at www.vmware.com.

Port

Type in the port number used to communicate with the View Connection Server.
To use the default value, simply leave it blank.

Use secure connection (SSL)

Check/Uncheck to enable/disable secure connection.

Certificate Checking Mode

Click the drop-down menu to select if to check server identity certificates

and if to connect to untrusted servers. Three options are available: Do not
verify server identity certificates, Warn before connecting to untrusted
servers, and Never connect to untrusted servers.

When Connection Ends

Click the drop-down menu to select what to do when the connection ends. Two
options are available: Return to VMware Pool and Quit VMware Client.

Option Description

When the connection ends, return to the Desktop

Return to VMware Pool and Application list for given credentials.

When the connection ends, close VMware Client.
Quit VMware Client To access virtual desktops and applications, you
need to provide the credentials again.

Login Settings

Item Description

Username Type in the user name for authentication.

Password Type in the password for authentication.

Domain Type in the domain name of the View Connection Server.

Desktop / Application Name

Type in the desktop / application name. Or, leave it blank for users to select one.

NOTE: You can use the Search icon O\g) to help you discover available desktops
or applications for a given set of credentials.
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Verify before Access

Click the drop-down menu to select whether to verify the entitlement to the
virtual desktop or application provided in the previous setting item:

Option Description

Verify the entitlement to the virtual desktop or application
Yes provided in the previous setting item. Stop if the given
credentials do not pass this verification.

If the given credentials are not entitled to the virtual

No desktop or application provided in the previous setting
item, just ignore that error and provide the Desktop and
Application list available for that credentials.

Preferred Display Protocol

Click the drop-down menu to select the desired display protocol. Three options
are available: Manual, Microsoft RDP, and PCoIP.

Option Description

Manual Manually select the desired display protocol.

Microsoft RDP Use Microsoft RDP as the display protocol.

PCoIP Use VMware PColIP as the display protocol.

Common Settings

Item

Description

Non-Interactive Mode

Select Yes or No to allow or disallow the Non-Interactive mode. The default is to
use the Non-Interactive mode.

Option Description

The Non-Interactive mode is used. Users are not allowed to
Yes re-select different settings if the settings have been specified
in View connection settings.

The Interactive mode is used. Users are allowed to
No re-select different settings even if the settings have been
specified in View connection settings.
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Autostart When Startup

Select whether to open a VMware View or Horizon View session automatically or
not when your t180L/t180LB is started up (Autostart mode).

NOTE: There are three similar but different modes for your t180L/t180LB and
only one mode will take effect if all are enabled. Three modes and the
order of priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
VMware View or Horizon View session and perform
the configured action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
VMware View or Horizon View session and perform
the configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a VMware View or Horizon View session is ended.
Four options are available: Do Nothing, Restart Application, Reboot,
and Shutdown.

Option Description

Do Nothing Returns to the local desktop.

Restart Application Opens a VMware View or Horizon View session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.




Options Sub-tab

Configuring Client Settings
Configuring Service Access Settings

Window Settings

Item Description
Click the drop-down menu to select the desired display size of a View session.
Three options are available: Full Screen, Large Window, and Small Window.
Option Description
Resolution Full Screen Opens the selected View session in full screen.

Large Window  Opens the selected View session in a large window.

Small Window  Opens the selected View session in a small window.

USB Redirection Settings

Item

Description

Mass Storage

Smart Card

Human Interface Device

Printer

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for VMware View Sessions”
on page 58 for detailed instructions on these similar settings.

Connection Settings

Item

Description

Printer Mapping

Click to enable/disable printer mapping for VMware View connections.

NOTE: You need to add a local or network printer for your t180L/t180LB first,
and then enable this feature here to use that mapped printer in a virtual
desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
t180L/t180LB, please refer to section “4.4.7 Adding a Local Printer” on
page 86 or “4.4.8 Adding a Network Printer” on page 89.

NOTE: Even you disable printer mapping, your printer might still be redirected
to a virtual desktop session if Printer Redirection is enabled (see above
settings in this table).
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Configuring Service Access Settings

SECUREMATRIX Sub-tab

Connection Settings

Item

Description

Use SECUREMATRIX

Check to use SECUREMATRIX authentication.

GSB Server Address

Type the server address of GSB server, the server for SECUREMATRIX
authentication service.

Username

Type your user name (Login ID).

(]

NOTE

- For details, please refer to “A.3 Using SECUREMATRIX Authentication for VMware
Connections”on page 216
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4.6.15 Configuring SSH Connection Settings

To configure SSH (Secure SHell) connection settings, please do the following:

1. On Atrust Client Setup, click Applications > SSH.

2. The SSH Connection list appears in the Configuration area.

o S T T T ]
® Atrust Client Setup N =N | W= B
Atrust Applications User Interface Devices Network System
TR - -

- Remote Desktop

o Citrix ICA

- WMware View
S5H

Session Name *  Server Address Connection Type

5/ NOTE

- If you haven't created any entry, the SSH Connection list will be empty.

3. Click Add on the top of the SSH Connection list to add a new entry of SSH connection.
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Configuring Service Access Settings

Atrust

Navigator

Remote Desktop
- Citrix ICA
o WMware Wiew
SSH

Atrust Client Setup lla LCl

Applications User Interface Devices Network System
General
Server Settings
Session Name: ] | &
Connection Server: * | | |_
Connection Type: |SSH j h.
Port: [22 | &
Username: * | | h.
I Save H Cancel ]

4. Click the drop-down menu to select the desired connection type. Two types are available: SSH and Telnet.

5. Type in the desired session name, the computer name or IP address of the remote server, the user name, and
then click Save to confirm.

6. The new entry is added to the SSH Connection list and the access shortcuts are automatically created

on the local desktop and START menu.

Atrust

Navigator

- Remote Desktop
o Citrix ICA

S WMware View

H

Atrust Client Setup

Applications User Interface

[ + Add H - Delete

Session Name % Server Address
IScA bbs.iscabbs.com

SDF sdfiorg

Devices

Network

Connection Type

Telnet
S5H
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4.6.16 Launching SSH and Telnet Sessions

To launch an SSH or Telnet session, please do the following:

1. Double click the created shortcut on the local desktop.

2. The SSH or Telnet session starts in the opened window.

Example: SSH Session

Terminal

Eile Edit View Terminal Geo Help

lelcome to the
You are the 11

[30-Jun-14 20:12:16
% full time

Example: Telnet Session

L= Terminal oo O

Eile Edit \iew Terminal Go Help

Own version of Citadel)

Welcome to the I . BBS.

Login as 'Guest' to just look around, or 'bh to create & new account.

lable to you, type <?>
e <l>
in depth, type <h> to enter the

account here,
in mind.
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Appendices

This chapter provides instructions on advanced settings, maintenance, and
upgrade for your t180L/t180LB.

A.1 Resetting Your t180L/t180LB to the Factory Default
How to restore factory default settings for your t180L/t180LB

A.2 Updating Firmware for Your t180L/t180LB
Four ways to update firmware for your t180L/t180LB

A.3 Using SECUREMATRIX Authentication for VMware Connections

Enabling SECUREMATRIX authentication
Using SECUREMATRIX authentication
Changing your password pattern
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A.1 Resetting Your t180L/t180LB to the Factory Default

To reset your t180L/t180LB to the factory default, please do the following:

@ WARNING

- Resetting your t180L/t180LB to the factory default will erase all current settings in
Atrust Client Setup and restore all settings to defaults.

1. Restart your t180L/t180LB.
2. During the POST (Power-on Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

Atrust Thin Client Menu

Normal Mode
Safe Mode
Reset Mode

Firmware update
Reboot
Shutdown

= NOTE

7/
+ You might need to wait about 15 seconds for this menu to appear on the screen.
- Six options are available on Atrust Thin Client Menu: Normal Mode, Safe Mode,

Reset Mode, Firmware update, Reboot, and Shutdown. See the table below for
the description of each option:

Menu Option Description

Normal Mode Boots up your t180L/t180LB as the normal startup procedure.
Safe Mode Clears and resets the current screen resolution setting.

Reset Mode Resets your t180L/t180LB to the factory default.

Firmware update  Updates firmware for your t180L/t180LB through the network.
Reboot Reboots your t180L/t180LB.

Shutdown Shuts down your t180L/t180LB.

3. Use arrow keys on the keyboard to select Reset Mode, and then press Enter on the keyboard to continue.
4. A message appears prompting for confirmation. Click y on the keyboard to confirm.

5. After completion, press Enter on the keyboard to restart your system.
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A.2 Updating Firmware for Your t180L/t180LB

Four ways are available to update firmware for your t180L/t180LB:

Method Description
Atrust Thin Client Menu Downloads firmware from a remote computer and updates firmware for your thin client.
USB Flash Drive Updates firmware with a USB flash drive created by Recovery USB Disk Creator.
Atrust Client Setup Initiates firmware update locally on the thin client with the help of Atrust Client Setup.
Atrust Device Manger Initiates firmware update remotely on the remote computer with Atrust Device Manager.

Using Atrust Thin Client Menu

To update firmware using Atrust Thin Client Menu, please do the following:

1. Connect your thin client to the network, and then restart it.
2. During the POST (Power-On Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

3. Select Firmware update and then follow the on-screen instructions to complete the task.

NOTE

+ You need to specify the IP address of the firmware server over the network. A
firmware server is the server where Atrust Device Manager is installed and client
firmware files are imported through Atrust Device Manager.

W)

« For more information about Atrust Device Manager, please refer to the User’s
Manual for Atrust Device Manager.

Using a USB Flash Drive

To update firmware using a USB flash drive created by Recovery USB Disk Creator, please do the following:

NOTE

(alll |

- Forinstructions on how to create a USB flash drive using Recovery USB Disk Creator,
please refer to the Quick Guide for USB Creator.

1. Plug the USB flash drive, and then restart your thin client.
During the POST period, press F7 to enter the Boot Device menu.

Select the USB flash drive on that menu to enter Atrust Thin Client Recovery System screen.

> W

Follow the on-screen instructions to complete the task.
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Using Atrust Client Setup

To update firmware using Atrust Client Setup, please refer to section “4.2.6 Updating Firmware from the
Management Computer” on page 48.

Using Atrust Device Manager

To update firmware using Atrust Device Manager, please refer to the User’s Manual for Atrust Device Manager.
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A.3 Using SECUREMATRIX Authentication for VMware Connections
Enabling SECUREMATRIX Authentication for Custom VMware Connections

To enable SECUREMATRIX authentication for a custom VMware connection, please do the following:

NOTE
- SECUREMATRIX authentication is not available in Quick Connection mode.

&

1. On the local desktop, click START > Settings > Atrust Client Setup to launch Atrust Client Setup.
2. Click Applications > VMware > Add to create a new entry of connection settings.

3. On the General tab, type the desired session name and the server address of View Connection Server.

: Lol dlalisal
® Atrust Client Setup o Lol
Atl'l.lSt Applicati User Interf: Devices Network System
General Options SECUREMATRIX
-~ Remote Desktop
o Citrix ICA - Server Settings
= WMware Wiew Session Name: * |VHV5 ‘ [
S5H Connection Server: * |VCS.V1—Mpoc ‘ e
Port: [ | &
Use Secure Connection(SSL): [ves hd I
Certificate checking mode: [Warn before connectingtor ~]
¢ Login Settings
User Name: | ‘ e
Password: [ =
Domain: [ | &
Desktop / Application Mame: < | E
Preferred Display Protocel: [Manual -l e
¢ Common Settings
Non-nteractive Mode: [ves 1&
Autostart When Startup: [Mo -] =
On Application Exit: | Do Nothing ;l e
Save l | Cancel

4, On the SECUREMATRIX tab, click to check Use SECUREMATRIX.
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B S HHHEE R HHHHHHHSSS SIS
®) Atrust Client Setup o ol
Atrust Applications  User Interface Devices Network System

General Options SECUREMATRIX
- Remote Desktop
- Citrix ICA - Connection Settings
- VMware View .__ Use SECUREMATRIX

WHVE
- SSH

Save H Cancel |

% NOTE

- By default, SECUREMATRIX authentication is disabled.

5. Two fields appear for you to provide SECUREMATRIX related information. Type the server address of GSB
server (the server for SECUREMATRIX authentication service).

- Connection Settings
L« Use SECUREMATRIX

GSB Server Address: + [192.168.0.77 | &

Username: | | L

6. Configure other connection settings if needed, and then click Save to confirm.

7. The access shortcuts will be created on the local desktop and START menu.
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Using SECUREMATRIX Authentication in VMware Connections

When SECUREMATRIX is enabled in your VMware connection, follow the steps and instructions below to use
SECUREMATRIX authentication:

1. Click the shortcut on the local desktop or START menu.
2. A window appears to prompt for the Login ID of SECUREMATRIX authentication.

i) Login

Login ID

( Change Password

3. Type your Login ID, and then click OK to confirm.

% NOTE

+ To change your password pattern, click Change Password. For details, please see
“Changing Your Password Pattern for SECUREMATRIX Authentication” on page 221.

4. The SECUREMATRIX window appears prompting for the password.

SECUREMATRIX

SECUREMATRIX

(7Jla)lz)e]) [e)(s](s])le) [2)(s)(z)(2) (z)[z](e]1]
[4)l7)ls)(e] [e)(e]lo])(s) [a)(7]()[2] [oJ[7](s](3]
s)lsl(z)la) [)s]le)ln) (3)(s)lz)le) [n)la](4](e]
[4)(s](z)s] [o)(z](s])lo] [s](s]lz)[s] (ell=](e](z]

Authentication

Password [ l

5. Type numbers under your password pattern using the keyboard or click numbers directly on the window,
and then click OK to confirm.
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- For example, if your password pattern is shown as below, type or click numbers,
0,0,4,51,3,6,2 insequence.

(ells)(s)e) [2)(s]07)(z]) [2)(2](o](2]
[s)ls)l2)(s] [a))(a)r) [eJz)(o)(=]
[2)(s)a)7) [=l(s)z)le]) [)(a](4](e]
[o)(2](s]e) [o)(s](7)(s]) [e)l=](e](1]

6. A message appears when SECUREMATRIX authentication is completed. Click OK to continue.

Motification from SECUREMATRIX
Last Login Timestamp : 2015-11-16
05:56:33

7. A message appears prompting to provide credentials for access to VMware virtual desktops and applications.
Click OK to continue.

No credentials, please enter,

User o [ ]
Password * [ ]
Domain e [ v]

9. The Desktop and Application list appears. Double-click to select the desired desktop or application.
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File Connection Wiew Help

[ ossmsnmec

Adobe Reader XI Calculator

4 )

Notepad Paint

LINE

Skype

Mozilla Firefox

[ |

W7U
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Changing Your Password Pattern for SECUREMATRIX Authentication
To change your password pattern for SECUREMATRIX authentication, please do the following:

1. On the window prompting for the Login ID as shown, type your Login ID, and then click Change Password.

Login ID [ |

( Change Password )

2. Type or click numbers under your old password pattern, and then click OK to continue.

SECUREMATRIX |

SECUREMATRIX

7Jls)lz)(e) [e)(s]ls]le) [2)(s]lz)(2]) (z)(2](s](1]
4)l7)le)le] [e)le]le])ls) [a)l7)l3)(2]) (o)(7](s](3]
(s)lells)la) [1)is]le)ln) [3)(slz)le) (7)la])l4](e]
[4)ls)l2)(s] [oJ(2]ls])le] [s](s]lz)ls) Lello]le](z]

Authentication

Password [ l

3. Type or click numbers under your new password pattern, and then click OK to continue.

SECUREMATRIX —
Your new SECUREMATRIX
e | FOEE BEEE @EEE

(2){s](5)(3] [7)z][e](7] [e][3](8][3]
(3){a)lo]2] [s)(7](e][2] [e][4](z][7]
[7){2](2]{3] [z](e][3][e] [e][e](2](2]

Authentication

Mew Password [ l
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4. Type or click numbers under your new password pattern again, and then click OK to continue.

SECUREMATRIX e

SECUREMATRIX

g7 I(3)(2)(2] [e](z]la]le] [2](2][2][2] [e][4](5](6]
flis](2)(s] [e](7])lel(s] [2](s)(s][z] [e][2](5](e]
[lellell2] [e][a]lal2] [2](4][3][2] [e][7](7](5]
lellsfi[2](4] (6]{4][e]e] [2][7][0](e]

Authentication

Confirm Passward [ l

5. A window appears showing your new password pattern in numerical order and prompting for confirmation.
Click OK to confirm.

SECUREMATRIX

8
7
6
5

Bl W NP

Confirmation




Specifications

Atrust t180L / t180LB thin clients

Specifications

Processor Intel® Bay Trail 1.83 GHz quad-core

Chipset Intel® NM10 (Graphics integrated)

System Memory 168

Flash Memory < EE

Resolutions Up to 1920 x 1200

1/0 interfaces Front: Rear:
2xUSB2.0 1xUSB 2.0 1x DVI-I
1 x Microphone 1xUSB 3.0 1xDVI-D
1x Headphone 1x RJ-45 1xDCIN

Networking 10/100/1000Mb Ethernet
Wireless IEEE 802.11 b/g/n (only for t180LB)
Power Input/Output: 100-240Vac, 1A, 50-60 Hz / DC +12Vdc, 3A

Operating system

Atrust Linux

Supported Protocols

Microsoft RDP with RemoteFX / Citrix ICA with HDX / VMware PColP

Man agement Atrust Client Setup / Atrust Device Manager

Security Kensington security slot

Mount / Stand t180L: VESA mount kit / Stand, (W)68 x (H)10 x (D)111 mm
t180LB: VESA mount kit, (W)62 x (H)14.5 x (D)114.5 mm

i e £180L: (W)39.5 x (H)143 x (D)103 mm
£180LB: (W)39.5 x (H)162.2 x (D)103 mm

WEight t180L: 446 g, including the dual-purpose stand / VESA mount kit

t180LB: 472 g

Environment

Operating Temperature: 0°C~35°C

Non-operating Temperature: -30°C~60°C

Operating Humidity (Rh): 10% ~ 90% (non-condensing)
Non-operating Humidity (Rh): 5% ~95%
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